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About This Document

This manual is intended for administrators and users of the
AXIS 243Q Blade Video Server, with firmware release 4.40.
The manual includes instructions for using and managing
the AXIS 243Q Blade on your network. Previous experience
of networking will be of use when installing and using this
product. Some knowledge of UNIX or Linux-based systems
would also be beneficial, for developing shell scripts and
applications. Later versions of this document will be posted
to the Axis Website, as required. See also the product’s
online help, available via the Web-based interface.

Safety Notices Used In This Manual

Caution! - Indicates a potential hazard that can damage the
product.

Important! - Indicates a hazard that can seriously impair
operation.

Do not proceed beyond any of the above notices until you
have fully understood the implications.

Intellectual Property Rights

Axis AB has intellectual property rights relating to
technology embodied in the product described in this
document. In particular, and without limitation, these
intellectual property rights may include one or more of the
patents listed at http://www.axis.com/patent.htm and one
or more additional patents or pending patent applications
in the US and other countries.

This product contains licensed third-party software. See the
menu item “About” in the product’s user interface for more
information.

Legal Considerations

Camera and audio surveillance can be prohibited by laws
that vary from country to country. Check the laws in your
local region before using this product for surveillance
purposes. This product includes one (1) MPEG-4 decoder
license. To purchase further licenses, contact your reseller.

Electromagnetic Compatibility (EMC)

This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful
interference to radio communications. However, there is no
guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful
interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or
more of the following measures: Re-orient or relocate the
receiving antenna. Increase the separation between the
equipment and receiver. Connect the equipment to an
outlet on a different circuit to the receiver. Consult your
dealer or an experienced radio/TV technician for help.
Shielded (STP) network cables must be used with this unit
to ensure compliance with EMC standards.

USA - This equipment has been tested and found to
comply with the limits for a Class B computing device
pursuant to Subpart B of Part 15 of FCC rules, which are
designed to provide reasonable protection against such
interference when operated in a commercial environment.
Operation of this equipment in a residential area is likely to
cause interference, in which case the user at his/her own
expense will be required to take whatever measures may be
required to correct the interference.

Europe - (¢ This digital equipment fulfills the requirements
for radiated emission according to limit B of EN55022/1998,
and the requirements for immunity according to EN55024/1998
residential, commercial, and light industry.

Australia - This electronic device meets the requirements of
the Radio communications (Electromagnetic Compatibility)
Standard AS/NZS CISPR22:2006.

Canada - This Class B digital apparatus complies with
Canadian ICES-003.

Japan - This is a class B product based on the standard of the
Voluntary Control Council for Interference from Information
Technology Equipment (VCCI). If this is used near a radio or
television receiver in a domestic environment, it may cause
radio interference. Install and use the equipment according to
the instruction manual.

Liability

Every care has been taken in the preparation of this manual;
Please inform your local Axis office of any inaccuracies or
omissions. Axis Communications AB cannot be held responsible
for any technical or typographical errors and reserves the right
to make changes to the product and manuals without prior
notice. Axis Communications AB makes no warranty of any
kind with regard to the material contained within this
document, including, but not limited to, the implied warranties
of merchantability and fitness for a particular purpose. Axis
Communications AB shall not be liable nor responsible for
incidental or consequential damages in connection with the
furnishing, performance or use of this material.

Trademark Acknowledgments

Ethernet, Internet Explorer, Linux, Microsoft, Mozilla, 0S/2,
UNIX, Windows, WWW are registered trademarks of the
respective holders. QuickTime™ is a trademark of Apple
Computer, Inc., registered in the U.S. and other countries. Java
and all Java-based trademarks and logos are trademarks or
registered trademarks of Sun Microsystems, Inc. in the United
States and other countries. Axis Communications AB is
independent of Sun Microsystems Inc. UPnP™ is a certification
mark of the UPnP™ Implementers Corporation.

Support Services

Should you require any technical assistance, please contact

your Axis reseller. If your questions cannot be answered

immediately, your reseller will forward your queries through

the appropriate channels to ensure a rapid response. If you are

connected to the Internet, you can:

e download user documentation and firmware updates

e find answers to resolved problems in the FAQ database.
Search by product, category, or phrases

e report problems to Axis support staff by logging in to your
private support area

e visit the Axis Support Web at www.axis.com/techsup/



Safety Notice - Battery Replacement

The AXIS 243Q Blade uses a 3.0V CR2032 Lithium battery
as the power supply for its internal real-time clock (RTC).
This battery will, under normal conditions, last for a
minimum of 5 years. Low battery power affects the
operation of the RTC, causing it to reset at every power-up.
A log message will appear when battery replacement is
required.

The battery should not be replaced unless required!
If the battery does need replacing, observe the following
points:

Caution!

e Danger of Explosion if battery is incorrectly replaced

e Replace only with the same or equivalent battery, as
recommended by the manufacturer.

¢ Dispose of used batteries according to the manufacturer’s
instructions.

AXIS 243Q Blade Video Server User’s Manual
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Copyright® Axis Communications AB, 2006-2007




AXIS 243Q Blade

Contents
Product description . ... oo e 6
OV VI W ottt 6
LED indicators . . ..ot 7
Switches & CoNneCtors ... ... . e 8
USIiNg the VIdEO SEIVEr . ...ttt e e 9
Accessing the Video Server ... ... .. i e 9
The Live View Page . ... ... 10
V@0 StrBAMS oottt ittt e et e e 12
Video stream types ... oot 12
MPEG-4 protocols and communication methods ............................ 13
AXIS Media Control (AMGC) . ..ot 13
How to stream MPEG-4 . ... .. ... . 13
Other methods of accessing the video stream . ........... ... .. ... .......... 14
Configuring the VIde0o SEIVEr . .. .ottt 15
Accessing the Setup tools . . ... .. o 15
Video & image Settings . ..ottt 16
IMmage Settings . ... .ot 16
Video source Settings ... ..o v it 17
Advanced - MPEG-4 settings .. ....... ...t 18
Advanced - Overlay/Mask settings ...............o it 18
Live View Config ..ot 21
LayOUL . 21
Event configuration ... ... o e 23
EVeNt SEIVEIS .o e 23
EVeNt fypeS . o o 24
Motion detection ... ... ... 26
Port status ... 27
Pan Tilt Zoom ... o e e 28
Installing PTZ deviCes . ... i e et e e 28
PTZ configuration .. ... ... .. . 29
PTZ controls . . ... o 30
Using PTZ on video inputs 2-4 . .. ... i e e 34
SYSEEM OPEIONS o e et 35
SO Uy ot 35
802.1x - Network Admission Control . ....... ... .. ... . ... . .. i 37
Date Ettime . ..o 39
Network - Basic TCP/IP settings . ....... ..., 40
Network - Advanced TCP/IP settings . . ...t 41
SOCKS 42
QoS (Quality of SEIVICE) . ... ot 43
SMTP (email) ..ot 43

SN 44

4



AXIS 243Q Blade

UPN P 44

RTP [ MPEG-4 . . . e 44
BoNjoUr . . 44

Ports Bt devices . ... o 44
MaintenanCe . ... ... 45
SUPPO o e 46
Advanced ... ... 46
Resetting to the factory default settings........... . i 47
[/O Terminal CONNECLOr . ..ottt e e e e e e e e e e e e e e e e e e 48
Schematic diagram - 1/0 terminal connector .................... ... ... 49
RS-485 COM port ..o e e e e 49
Troubleshooting . . ... e 50
Checking the firmware .. ... ... .. i e 50
Upgrading the firmware .. ... ... 50
SUPPOI .« ot 52
Technical specifications ... ... ... . e 55
General performance considerations . . ......... . . i 58
Optimizing your System . ... . 58
Bandwidth ... ... 59
GlOSSaNY .« vttt e e e e 60

T 1S 69

5



AXIS 243Q Blade - Product description

Product description

Overview

The AXIS 243Q Blade Video Server is a fully featured video server intended for security
surveillance and remote monitoring needs. It is designed for mounting in the AXIS 291
Video Server Rack, which provides power and network connectivity.

LED Indicators

The AXIS 243Q Blade video server is a 4-in-1 solution, which means that each physical
blade unit contains 4 separate video servers, one for each video input. The individual video
servers display as AXIS 243Q(1) Blade, AXIS 243Q(2) Blade, AXIS 243Q(3) Blade and AXIS
243Q(4) Blade. The descriptions that follow apply to all 4 video servers, except where
otherwise indicated.

The 4 BNC inputs on AXIS 243Q Blade are for connecting analog video devices. The video
server digitizes up to 4 analog video sources and makes them available on the network as
real-time, full frame rate MPEG-4 and/or Motion JPEG video streams.

Each video input provides 1 alarm input and 1 alarm output that can be used to connect
various third party devices, e.g. door sensors and alarm bells. The AXIS 243Q(1) Blade
provides an RS-485 port for connecting e.g. third-party PTZ systems. PTZ devices can also
be used on AXIS 243Q(2) Blade, AXIS 243Q(3) Blade and AXIS 243Q(4) Blade, by creating
an internal connection to these from AXIS 243Q(1) Blade.
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Up to 20 viewers can access each video input on the AXIS 243Q Blade simultaneously
when using Motion JPEG and MPEG-4 unicast. The number of simultaneous viewers can
be increased by using multicast MPEG-4. When using AXIS Media Control (AMC) to view
MPEG-4 video streams, each MPEG-4 viewer requires a separate MPEG-4 decoder license.
One licence is included, and further licenses can be purchased separately from your Axis
dealer. If using other clients to view the MPEG-4 video stream, no further MPEG-4 decoder
licenses are required.

Video can be viewed in 5 resolutions (up to 4CIF), and image compression is configurable.
The AXIS 243Q Blade contains support for video motion detection, which allows the unit
to trigger on activity in the video image, and advanced scheduling tools which can also be
used to trigger an event. As the AXIS 243Q Blade is designed for use in security systems, it
is equipped with several security features, such as IP address filtering, user levels with
passwords, and HTTPS.

Each video input on the AXIS 243Q Blade has a built-in web server, providing full access
to all features through the use of a standard web browser. The built-in scripting tool allows
the creation basic applications to be created, providing basic surveillance solutions. For
advanced functionality, the video server can be integrated via the use of the AXIS VAPIX
API (see www.axis.com/developer for further information).

LED indicators

After completion of the startup and self-test routines, the multi-colored LED indicators
signal the following conditions:

Network Green Steady green - no network activity

Flashes green - network activity

Status Green Steady green - normal operation

Red One flash - one or more units starting up

Two flashes - a unit is resetting to factory default settings

Steady red - hardware error on one or more units

Green/red Flashes for no connection to AXIS Internet Dynamic DNS Service

Power Green Normal operation

Green/Amber | Flashes for unit upgrade
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Switches €t connectors

DIP switches - A corresponding line termination switch is supplied for each video input.
Units are shipped with line termination enabled for each video input; that is, with the DIP
switch set in the down position.

Control Button - Press this button to restore the factory default settings, as described in
Resetting to the factory default settings, on page 47, or to install using AXIS Internet
Dynamic DNS Service (see the Installation Guide).

Video Input - Each video input is connected using a coax/BNC connector. Physical
connections made using 75 ohm coaxial video cable have a recommended maximum
length of 250 meters (800 feet).

8
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Using the video server

The AXIS 243Q Blade can be used with most standard operating systems and web
browsers. The recommended browser is Internet Explorer with Windows, and Mozilla with
other operating systems. See also the Technical specifications, on page 55.

Note: For information on installing the video server, please refer to the Installation Guide.

Acces Sing the video server  Live view - AXIS 2430 Blade Video Server
1. Star‘t your Web brOWSﬁr. J File Edit \iew Favorites Tools  Help
Y Back ~ £ - [x] |2 N | 2 search

2. Enter the IP address or host name of the lo O i Gl

J Address I <enter IP address here=

video input on the AXIS 243Q Blade you
wish to configure in the Location/Address field of your browser.

3. Enter the user name and password.

4. The Live View page is displayed in your browser.

AXISa AXIS 243Q Blade Video Server Live View | Setup | Help

Video farmat

Motion JPEG -l

Stopped

000

Notes: eTo view streaming video in Microsoft Internet Explorer, you must set your web browser to allow
the AXIS Media Control (AMC) to be installed on your computer. AMC provides an MPEG-4
decoder for viewing MPEG-4 video streams. This decoder is installed the first time an MPEG-4
video stream is accessed. Please note that the product administrator may have disabled the

installation of the decoder, as a license is required for each instance. See page 22 for more
information.
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o|f your workstation restricts the use of additional software components, the AXIS 243Q Blade

can be configured to use a Java applet for updating JPEG images. Please see the online help for
more information.

*When using a browser other than Microsoft Internet Explorer with AMC, instead of a stop, a
snapshot and a full screen button, there is a stop and a play button in the bottom left corner of
the Live view page. For a description of these buttons see The Live View Page, below.

The Live View Page

If your AXIS 243Q Blade has been customized to meet specific requirements, the buttons
and other items described below may or may not be displayed on the Live View page. The
following provides an overview of each available button:

wWideo format

IM i PES vI

The Video Format drop-down list allows the video format on the Live
View page to be temporarily changed.

The Output buttons control  Gutpit 1: Pulse - click this button to activate the port

an output directly from the e for' a defined period of time, e.g. to switch on
Live View page. These a light for 20 seconds.

buttons are configured . . .

under Setup > Live View output 2. Active/Inactive - click these buttons to .
Config > Layout. 6@ manually start and stop a connected device,

e.g. switch a light on/off.

The trigger buttons trigger an event directly from the Live View page. These
buttons are configured under Setup > Live View Config > Layout. Click these
buttons to manually start and stop events.

Trigger

0®

snapshot.  Use the Snapshot button to capture a snapshot of the image currently being

O displayed in the window. Right-click on the image to save it in on your
computer.

The AMC viewer toolbar (AXIS Media Control) is available in Microsoft Internet
Explorer only and displays the following buttons:

o O The Play/Stop buttons start and stop the media stream.

The Snapshot button saves a snapshot of the video image currently being

O displayed. The Snapshot function and the target directory for saving snapshots
can be configured from the AMC Control Applet, which can be opened from the
Windows Control Panel or by right-clicking the image in Internet Explorer.

10
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Click the View Full Screen button and the video image will fill the entire screen
O area. No other windows will be visible. Press Esc (Escape) on your keyboard to

cancel full screen view.

Click the Record button to start an MPEG-4 recording (only available when

viewing MPEG-4).

Note that these AMC toolbar functions can also be accessed by right-clicking in the image.
For information on using Pan/Tilt/Zoom controls, please see Pan Tilt Zoom, on page 28.
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Video streams

The AXIS 243Q Blade provides several different video stream formats. The type to use
depends on your requirements and on the properties of your network.

The Live View page in the AXIS 243Q Blade provides access to Motion JPEG and MPEG-4
video streams, as well as to single JPEG images. Other applications and clients can also
access these video streams/images directly, without going via the Live View page.

Video stream types

Motion JPEG

This format uses standard JPEG still images in the video stream. These images are then
displayed and updated at a rate sufficient to create a stream that shows constantly updated
motion.

The Motion JPEG stream provides excellent image quality and access to each and every
individual image contained in the stream.

Note also that multiple clients accessing Motion JPEG streams can use different image
settings.

MPEG-4
This is a video compression standard that makes good use of bandwidth, and which can
provide high-quality video streams at less than 1 Mbit/s.

The MPEG-4 standard provides scope for a large range of different coding tools for use by
various applications in different situations, and the AXIS 243Q Blade provides certain
subsets of these tools. These are represented as Video object types, which are selected for
use with different viewing clients. The supported video object types are:

e Simple - sets the coding type to H.263
e Advanced Simple - in Axis products, this sets the coding type to MPEG-4 Part 2

AMC (AXIS Media Control) supports both object types, while e.g. QuickTime™ requires the
Simple object type.

When using MPEG-4 it is also possible to control the bit rate, which in turn allows the
amount of bandwidth usage to be controlled. CBR (constant bit rate) is used to achieve a
specific bit rate by varying the quality of the MPEG-4 stream. When using VBR (variable
bit rate), the quality of the video stream is kept as constant as possible, at the cost of a
varying bit rate.

Notes: eMPEG-4 is licensed technology. The AXIS 243Q Blade includes one license for the decoder
required for viewing in AMC. Installing additional unlicensed copies of this decoder is prohib-
ited. To purchase more decoder licenses, contact your Axis reseller.

®All clients viewing the MPEG-4 stream must use the same image settings.
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MPEG-4 protocols and communication methods

To deliver live streaming video over IP networks, various combinations of transport
protocols and broadcast methods are employed.

e RTP (Real-Time Transport Protocol) is a protocol that allows programs to manage
the real-time transmission of multimedia data, via unicast or multicast.

e RTSP (Real-Time Streaming Protocol) serves as a control protocol, to negotiate
which transport protocol to use for the stream. RTSP is thus used by a viewing
client to start a unicast session, see below.

e UDP (User Datagram Protocol) is a communications protocol that offers limited
service for exchanging data in a network that uses the Internet Protocol (IP). UDP
is an alternative to the Transmission Control Protocol (TCP). The advantage of
UDP is that it is not required to deliver all data and may drop network packets
when there is e.g. network congestion. This is suitable for live video, as there is
no point in re-transmitting old information that will not be displayed anyway.

e Unicasting is communication between a single sender and a single receiver over a
network. This means that the video stream goes independently to each user, and
each user gets their own stream. A benefit of unicasting is that if one stream fails,
it only affects one user.

e Multicast is bandwidth-conserving technology that reduces bandwidth usage by
simultaneously delivering a single stream of information to multiple network
recipients. This technology is used primarily on delimited networks (intranets), as
each user needs an uninterrupted data flow and should not rely on network
routers.

AXIS Media Control (AMC)

The recommended method of accessing live video (MPEG-4 and/or Motion JPEG) from the
AXIS 243Q Blade is to use the AXIS Media Control (AMC) in Microsoft Internet Explorer in
Windows. This ActiveX component is automatically installed on first use, after which it
can be configured by opening the AMC Control Panel applet from the Windows Control
Panel. Alternatively, right-click the video image in Internet Explorer.

How to stream MPEG-4

Deciding on the combination of protocols and methods to use depends on your viewing
requirements, and on the properties of your network. Setting the preferred method(s) is
done in the control applet for AMC, which is found in the Windows Control Panel. When
this has been set, AMC will test all the selected methods in the specified order, until the
first functioning one is found.

RTP+RTSP

This method (actually RTP over UDP and RTSP over TCP) should be your first consideration
for live video, especially when it is important to always have an up-to-date video stream,
even if some images do get dropped. This can be configured as multicast or unicast.
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Multicasting provides the most efficient usage of bandwidth, especially when there are
large numbers of clients viewing simultaneously. Note however, that a multicast broadcast
cannot pass a network router unless the router is configured to allow this. It is thus not
possible to multicast over e.g. the Internet.

Unicasting should be used for video-on-demand broadcasting, so that there is no video
traffic on the network until a client connects and requests the stream. However, if more
and more unicast clients connect, the server will at some point become overloaded. There is
also a maximum of 20 simultaneous viewers to be considered.

RTP/RTSP
This unicast method is RTP tunneled over RTSP. This can be used to exploit the fact that it
is relatively simple to configure firewalls to allow RTSP traffic.

RTP/RTSP/HTTP or RTP/RTSP/HTTPS
These two methods can also be used to traverse firewalls. Firewalls are commonly
configured to allow the HTTP protocol, thus allowing RTP to be tunneled.

Other methods of accessing the video stream
Video/images from the AXIS 243Q Blade can also be accessed in the following ways:
e [f supported by the client, the AXIS 243Q Blade can use Motion JPEG server push to

display video. This option maintains an open HTTP connection to the web browser and
sends data as and when required, for as long as required.

¢ As single JPEG images in a browser. Enter e.g. the path:
http://<ip>/axis-cgi/jpg/image.cgi?resolution=CIF

¢ Windows Media Player. This requires AMC and the MPEG-4 decoder to be installed. The
paths that can be used are listed below, in the order of preference.

eUnicast via RTP: axrtpu://<ip address>/mpeg4/media.amp

eUnicast via RTSP: axrtsp://<ip address>/mpeg4/media.amp

eUnicast via RTSP, tunneled via HTTP: axrtsphttp://<ip address>/mpeg4/media.amp
eUnicast via RTSP, tunneled via HTTPS: axrtsphttps://<ip address>/mpeg4/media.amp
eMulticast: axrtpm://<ip address>/mpeg4/media.amp

Other MPEG-4 clients

Although it may be possible to use other clients to view the MPEG-4 stream, this is not
guaranteed in all cases. For some clients, e.g. QuickTime™ the Video Object Type must be
set to Simple. It may also be necessary to adjust the advanced MPEG-4 settings.

To access the video stream from e.g. QuickTime™ the following path can be used:
rtsp://<ip address>/mpeg4/media.amp

This path is for all supported methods, and the client will negotiate with the AXIS 243Q
Blade to determine exactly which transport protocol to use.
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Configuring the video server

This section describes how to configure the AXIS 243Q Blade and is intended for
administrators, who have unrestricted access to all the Setup tools

The AXIS 243Q Blade is configured from the Setup link, in a standard web browser. For
more information on supported browsers, see the Technical specifications, on page 55.
Note that each video input must be configured separately.

Accessing the Setup tools
Follow the instructions below to access the Setup Tools from a web browser.

1. Start the browser and enter the IP address or host name of video input on the
AXIS 243Q Blade you wish to confogure in the location/address field.

2. The Live View page is now displayed. Click Setup to display the Setup tools.

Setup tools

AXISa AXIS 243Q Blade Video Server Live View | Setup | Help

Video format

IMOt\on JPEG =

Stpped

000
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Video & image settings

The following descriptions show examples of the available features in the AXIS 243Q
Blade. For details of each setting, please refer to the online help available from each page.
Click @) to access the online help.

Image settings

Image Settings (?)
Image Appearance

Reszolution: I_Aspect ratio correction

¥ ac1F de-interlacing

[4c1F (704 = 57¢) = |
Compression: ISD— [0..100]
Rotate image: m degrees
Colar satting: Im
Tent Overlay Settings
[T Indude date [T 1ndude tirme

[T Incude text: I
Text calor: Iwhite vl Text background color: Iblack vl
Place text/dateftime at Itop vl of image

Yideo Stream

Maximum video stream time:

® Unlirnited
irnited to .1 |seconds =] per zession
C Limited to | [1.] [seconds =] p i
Maxirmurn frame rate:
& Unlirnited
Lirnited to 1..20 5 per viewer
s dto | [1..20] fps p
Test
Tast settings (uszing Motion JPEG) before saving. Tast I

Save Reset

Image appearance
Modify the Image Appearance to optimize the video images according to your
requirements.

All configuration of images and overlays will affect the performance of the video server,
depending on usage and the available bandwidth.

¢ High resolution generates larger files

e Lower compression improves image quality, but generates larger files

e Black & White uses less bandwidth than Color

e Rotating the image 90 or 270 degrees will lower the maximum frame rate
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Text overlay settings

Include date, time and/or text of your choice to be viewed on the image. The color of the
text may be set to white or black, while background color may be set to white, black,
transparent or semitransparent. The position of the text is set either to the top or the bot-
tom of the image.

Video stream

The Maximum video stream time can be set as Unlimited, or set a maximum stream time
per session in seconds, minutes or hours. When the set time has expired, a new stream on
the Live View page can be started by refreshing the page in the web browser. Note that the
maximum video stream time does not apply to clients connecting via multicast.

To avoid bandwidth problems on the network, the frame rate allowed to each viewer can
also be limited. Select either Unlimited or define a maximum frame rate per viewer.

Test
For a preview of the image and overlay settings before saving, click Test. When you are
satisfied with the settings, click Save.

Video source settings

These settings allow you to eliminate any black borders surrounding the image, by making
Offset adjustments. See the online help for more information.
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Advanced - MPEG-4 settings
Tools for adjusting the MPEG-4 settings and for controlling the video bit rate.

The MPEG-4 standard provides many different coding tools for various applications in
different situations. As most MPEG-4 clients do not support all of these tools, it is usual to
instead define and use subsets for different clients or groups of clients. These settings allow
you to define the type of viewing client to use.

Adjusting the maximum bit rate and setting it to variable or constant is a good way of
controlling the bandwidth used by the MPEG-4 video stream.

For more information on these advanced settings, please see the online help.

Advanced - Overlay/Mask settings

Overlay/Mask type

Overlay/Mask type allows you to ovgﬁ;‘;‘,/v SRECL Ul
place an overlay, or up to three pri- .
vacy masks over the video image: Image
¢ Upload and place an Overlay
image as an overlay -
usually used to provide
extra information in the
video image.
¢ Place up to 3 configurable
privacy masks to conceal
different areas of the

video image. OO0

Selecting the overlay/mask type
from the menu will display further
settings available for the selected type. See the online help for further information.

Note: A privacy mask cannot be bypassed, but an overlay image can be bypassed with the help of the AXIS VAPIX
APIL.

Upload and use an overlay image

1. Select Uploaded image as overlay in the drop-down list for Overlay/Mask Type.
New options appear.

2. In the field Upload own image, click the Browse button and locate the image file
on your computer or server.

3. Click the Upload button and follow the on-screen instructions.

To use an already uploaded image:

1. Select an uploaded image from the Use image drop-down list.

18
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2. Place the image at the required location by entering the x and y coordinates.
3. Click Save.

AXISa AXIS 243Q Blade Video Server Live ¥iew | Setup | Help
Overlay/Mask Settings (2]

OverlayfMask Type

» Basic Configuration

- ¥ideo & Image
Cwerlay/Mask Tupe: Uploaded image as averla -
Image v vp |up a ¥ =l
Yideo Source Image for Overlay
» Advanced Uplaad own image: Browse... I Upload
Overlay/Mask
Use image: [ieteroverlaysiaxisi1zax44) 0vl =]
» Live Yiew Confi
4 Place image at the coordinates: ><| YI
» PTZ Configuration Remove image: Rarmoua selected image |
» Event Cunflguratlon Mote: Irmages that exceed the dimensions of the video image will be disabled.

Test Overlay/Mask Settings

Test after zaving. Test |
About Save Reset I

+ System Options

Overlay image requirements:

Image Formats Image Size
e Windows 24-bit BMP (full color) The height and width of the overlay image in
o Windows 4-bit BMP (16 colors) pixels must be exactly divisible by 4.

Overlay image limitations:
¢ The maximum overlay image size supported by the AXIS 243Q Blade is the same
as the maximum image resolution. See the Technical Specifications, on page 55.

¢ When a text overlay is also used, this reduces the amount of space available to
the overlay image. To keep the text readable at lower resolutions, the text overlay
occupies proportionally more of the image at lower resolutions.

e [f the overlay is initially positioned so that part of it is outside the video image, it
will be relocated so that it appears over the video image, i.e. it is always the entire
image that is displayed.

Please see the online help €) for more information.
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To use privacy masks to hide different areas of the video image:

1. Select Configurable areas as privacy mask in the drop-down list for
Overlay/Mask Type. New options appear.

2. Enter the (x,y) coordinates of the top left hand corner of the mask, and the height
and width to define the masks’ placement and size.

Select the privacy masks’ color: black, grey, white, or red.

4. Click in the box beside Enable to enable one or more of the masks you have
defined and click on Save.

AXISa AXIS 243Q Blade Video Server Live View | Setup | Help

» Basic Configuration
~ Video & Image
Image
Video Source
» advanced
Overlay/Mask
» Live View Config
» Event Configuration

» System Options

About

Overlay/Mask Settings (2]

oOverlay/fMask Type

Owerlay/Maszk Type: IConflgurabIe areas as privacy mask;l

Privacy Mask Areas

Masking area 1: [T Enable
i x) Iidth: ID
w o] Height: ID
Mazking area 2: l_ Enable
o |0 Iidth: ID
W [u] Height: ID
Masking area 3: l_ Enable
o |0 Iidth: ID
w |0 Heights |o

Privacy mask color: Black vl

Mote: (x,y) = position of top left corner of privacy mask area, Max = 640x4380
Test Overlay fMask Settings

Test after zaving, Test |

Save Reset
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Layout

The settings on this page concern which
features to include on the Live View page,
e.g. buttons and links.

User-defined Links

Enter a descriptive name and enter the
URL in the field provided. The link will
appear on the Live View page.

User defined CGI links can be used to issue
HTTP API requests, e.g. PTZ commands.
For example:

1. Check Show Custom Link 1

2. Enter a descriptive name, e.g. CAM1
Start PTZ.

3. Enter the cgi link:
http://192.168.0.125/axis-cgi/com/ptz.
cgi?camera=1€&continuouspantiltmove
=30,-30

4. Check Show Custom Link 2.

5. Enter a descriptive name, e.g. CAM1
Stop PTZ.

6. Enter the cgi link:

Live View Layout O

User Defined Links

™ Show custam link 1 Use as: ™ cgilink O web link
Marne: [Costorn fink 2| URLs s

™ Show custam link 2 Use as: ™ egilink 0 web link
Marme: [Costorn fink 2 | vRLs [heperr

T Show custam link 2 Use as: ™ egilink € web link
Narme: [Costorn fink 3 | URLs [heprrr

™ show custom link 4 Use as:  © cgilink € web link
Marme: [Costorn fink 4 vRLs [heprrr

Action Buttons
™ show manual trigger buttan

™ show snapshot button
Output Buttons

outputl [ -
Default ¥ideo Format
Motion JPEG =

! show uideo format selection

video format:

Default ¥Yiewer

Windows Intemet Exploren | =]
PE— |
Yiewer Settings

' shaw viewer taslbar

¥ Ensble MPEG-4 decoder installstion

' show crosshair in PTZ joystick rode”

I Use prz joystick mode as default®

™ Ensble recording button for MPEG-4

with MPEG-4, Motion JPEG will be shown with AMC in
ith seruer push in other browsers.

“Mot spplicable to Windows Internet Explorer,

Save I Reset

http://192.168.0.125/axis-cgi/com/ptz.cgi?camera=1€tcontinuouspantiltmove=0,0

7. These links will appear in the web interface and can be used to control the PTZ camera

For more information on the AXIS VAPIX HTTP API, see the Developer pages at the Axis
web site www.axis.com/developer. See also the section on PTZ, on page 28.

Action Buttons

These buttons can be used to manually start and stop an event from the Live View page.
See Event configuration, on page 23. The snapshot button allows you to take a snapshot of

the video stream and save it to a computer.
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Output Buttons
These buttons are used to control the outputs on the AXIS 243Q Blade and thus the
equipment connected to them, e.g. to switch a light on or off:

e The Pulse button activates the port for a defined period
e Active/Inactive displays 2 buttons, one for each action (on/off)

Default Video Format

Select the default format to use on the Live View page. Checking the box for Show video
format selection displays a drop-down list on the Live View page allowing you to
temporarily change the format.

Default Viewer
Select from the drop-down list the viewer you wish to use for your web browser. Please see
the online help for more information.

Viewer Settings
Show viewer toolbar - Check this to display the veiwers own toolbar under the image.

Enable MPEG-4 decoder installation - By checking/unchecking this box, the
administrator can enable or disable the installation of the MPEG-4 decoder included with
AMC. This is used to prevent the installation of unlicensed copies. Further decoder licenses
can be purchased from your Axis dealer.

Show crosshair in PTZ joystick mode (AXIS 243Q(1) Blade only) - This will enable the
display of a crosshair in the video image when the the PTZ mode is set to joystick.

Use PTZ joystick mode as default (AXIS 243Q(1) Blade only) - Enabling this sets the PTZ
mode to joystick. The mode can be changed temporarily on the PTZ Control Panel, but will
default to joystick if this is selected.

Enable recording button for MPEG-4 - Enabling this button allows the user to start an
MPEG-4 recording directly from the Live View page.

22
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Event configuration

This section describes how to configure the AXIS 243Q Blade for alarm handling. Various
actions can be configured to run when certain types of events occur.

Event type A set of parameters describing how and when the video server is to perform certain actions

- the circumstances that start an event | e.g. at a signal from an external device, such as a door

Triggered Event (see page 24) switch or a motion sensor

Scheduled Event (see page 25) | - the circumstances that start an event | e.g. at a pre-programmed time

- what occurs when the event runs e.g. video images uploaded to an FTP server, email noti-

Acti L
ction fication sent, etc.

Event servers

Event Servers are used for e.g. receiving uploaded image files and/or notification messages.
To set up event servers for your AXIS 243Q Blade, go to Setup > Event Configuration >
Event Servers and enter the required information according to the selected server type.

Server type Purpose Information required

® receives uploaded images Descriptive name of your choice

User Name and Password (to FTP server)

Upload path, e.g. images/

Port number

Use passive mode if there is a firewall between the video

server and FTP server

e Use a temporary file if your FTP server does not allow an
existing file to be overwritten by a new file with the same
name.

FTP Server

® receives notification messages
® receives uploaded images

Descriptive name of your choice

URL (address)

User Name and Password (to HTTP server)
Proxy address/Proxy port (if required)

Proxy User Name and Password (if required)

HTTP Server

® receives notification messages Descriptive name of your choice

TCP Server e Port number

For details on each setting, please refer to the online help @) available from each web
page.

Note: The images in pre-trigger and post-trigger buffers will be lost if the connection to the event server fails.

When the setup is complete, the connection can be tested by clicking the Test button (the
test takes approximately 10 seconds).



Event types

An event type is a set of
parameters describing how
and when the video server
is to perform certain

AXlSa,

» Basic Configuration
» Video & Image
» Live View Config

~ Event Configuration
Instructions

AXIS 243Q Blade - Event configuration

AXIS 243Q Blade Video Server

Event Types
Event Type List

Hame Status

Enabl.

Priority

Live View | Setup | Help

Trig. /Sched. Actions®

Ly Event
Scheduled up... TInactive
Triggered up... Inactive

Inactive

Tes
o
Tes

Hormal
Hormal
Hormal

Hanual Fu
Time frame Hn
Video loss En

Event Servers
Event Typaes

¥ Mation Detection
Part Status

actions.

» System Options

Example: If somebody walks past
the connected camera, and an event
has been configured to act on this,
the video server can e.g. record and
send video images to an FTP server, or send a notification email to a pre-configured email address with a pre-con-
figured message. Video images can be sent as an attachment with the email.

Add wiggered... | Add scheduled.. | copy Modify.. | Remove |

About *Fu=FTP upload, Hu=HTTP uplaad, Eu=Email upload, O=Cutput port, En=Email netificstion,
an. i set,

Hn=HTTP notification, Tn=TCP notification, P=PTZ pre

Triggered Event
A triggered event is activated by e.g:

e asignal on an input port, from e.g. a connected pushbutton

e detected movement in a configured motion detection window

¢ when the video signal is lost

e a manual action e.g. clicking the trigger button in the web interface
e on restart (reboot) after e.g. power loss

How to set up a triggered event
This example describes how to set the AXIS 243Q Blade to upload images when a door is
opened:

. Click Add triggered on the Event types page.
. Enter a descriptive name for the event, e.g. Main door.

1
2
3. Set the priority - High, Normal or Low (see the online help).
4. Enter the minimum time interval between triggers.

5

. Set the Respond to Trigger... parameters, for when the event is to be active,
e.g. only after office hours

6. Select the trigger alternative from the Triggered by... drop-down list,
e.g. an input port with a connected sensor if the door is opened.

7. Set the When Triggered... parameters, i.e. what the video server should do if the
door is opened, e.g. upload images to an FTP server.

8. Click OK to save the event in the Event Types list.

Please see the online help ¢) for descriptions of each available option.
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Pre-trigger and post-trigger buffers

This function is very useful when checking to see what happened immediately before and
after a trigger, e.g. 2 minutes before and after a door was opened. Check the Upload
images checkbox under Event Types > Add Triggered... > When triggered... to expand
the web page with the available options.

Buffer size - 9 MB per input. The maximum length of time of the pre-/post-buffer depends
on the selected image size and frame rate.

Include pre-trigger buffer - images stored internally in the server from the time
immediately preceding the trigger. Check the box to enable the pre-trigger buffer, enter the
desired length of time and specify the required image frequency.

Include post-trigger buffer - contains images from the time immediately after the trigger.
Configure as for pre-trigger.

Note: If the pre- or post-buffer is too large for the AXIS 243Q Blade's internal memory, the frame rate will be
reduced and individual images may be missing. If this occurs, an entry will be created in the unit's log file.

Continue image upload (unbuffered) - enable the upload of images for a fixed length of
time. Specify the length of time for the uploaded recording, in seconds, minutes or hours,
or for as long as the trigger is active. Finally, set the desired image frequency to the
maximum (the maximum possible) or to a specified frame rate. The frame rate will be the
best possible, but might not be as high as specified, especially if uploading via a slow
connection.

Scheduled event
A Scheduled event can be activated at pre-set times, in a repeating pattern on selected
weekdays.

How to set up a scheduled event
This example describes how to set the video server to send an email notification with saved
images from a set time:

1. Click Add scheduled on the Event types page.

2. Enter a descriptive name for the event, e.g. Scheduled email.
3. Set the priority (High, Normal or Low).
4

. Set the Activation Time parameters (24h clock) when the event should be active,
e.g. start on Sundays at 13.00 with a duration of 12 hours.

5. Set the When Activated... parameters i.e. set what the video server should do at
the specified time e.g. send uploaded images to an email address.

6. Click OK to save the Event in the Event Types list.

Please see the online help ¢) for descriptions of each available option.
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Motion detection
In the Motion Detection menu, you can configure the video source(s) for motion detection.
The motion detection feature is used to generate an alarm whenever movement occurs (or
stops) in the image. The AXIS 243Q Blade can use a maximum of 10 Include/Exclude
windows per video input.

¢ Include windows target specific areas within the image

¢ Exclude windows are areas to be ignored within the Include window
Once configured, the motion detection windows will appear in a list when motion
detection is selected to trigger an event. See How to set up a triggered event above.

Note: Using the motion detection feature may decrease overall performance in the video server.

AXISa AXIS 243Q Blade Video Server Live view | Setup | Help

.............

Motion Detection (9]

@& Configure Included  (~ Configure Excluded
Windows Windows

}+ Basic Configuration
» Video & Image
» Live Yiew Config

- Event Configuration
Instructions
Event Servers
Event Types
Motion Detection
Port Status

Object Size
» System Options

History
About

Sensitivity

Activity

& Wiew Al Windows

€ Wiew Selected Window

How to configure Motion Detection
This example describes how to configure motion detection:

1. Click Motion Detection in the Event Configuration menu.

2. Click the Configure Included Windows radio button.

3. Click New.

4. Enter a descriptive name of your choice under Windows name.
5

. Adjust the size (drag the bottom right-hand corner) and position (click on the text
at the top and drag to the desired position).
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6. Adjust the Object size, History and Sensitivity profile sliders (see table below for
details). Any detected motion within an active window is then indicated by red
peaks in the Activity window (the active window has a red frame).

7. Click Save.

If there are parts of the Include window that you wish to exclude, click the
Configure Excluded Windows radio button and perform steps 1-6 above.

Click Save.

Please use the online help €) for descriptions of each available option.

trigger motion detection

trigger motion detection for only a very
short period

Parameter | Object Size History Sensitivity
High Only very large objects An object that appears in the region will | Ordinary colored objects against ordinary
trigger motion detection | trigger the motion detection for a long backgrounds will trigger the motion
period detection
Low Even very small objects An object that appears in the region will | Only very bright objects against a dark

background will trigger motion detection

Default values

Low

Medium to High

Medium to High

Examples:

* Avoid triggering on small objects in the image by selecting a high size level.

* To trigger motion detection as long as there is activity in the area, select a high history level.

e To only detect flashing light, low sensitivity can be selected. In other cases, a high sensitivity level is
recommended.

Port status

Under Event Configuration > Port Status, there is a list that shows the status for the
connected inputs and outputs of the AXIS 243Q Blade. This is for the benefit of an
operator, who cannot access the System Options section.

Example: If the Normal state for a e.g. a pushbutton connected to an input is set to Open circuit, as long as the but-

ton is not pushed, the state is inactive. If the button is pushed, the state of the input changes to active.
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Pan Tilt Zoom

Installing PTZ devices

Video input 1 on the AXIS 243Q Blade supports several Pan Tilt Zoom (PTZ) devices.
Please see www.axis.com for a complete list of supported devices, and to obtain the correct
driver. PTZ devices can also be used on video inputs 2-4, by creating an internal
connection to them from input 1. For further information see page 34.

Follow the instructions below to install a PTZ device:

1. Using an appropriate cable, connect the PTZ device to the RS-485 port, which is
available via the I/O terminal connector on the AXIS 291 Video Server Rack. See
page 48 for more information.

2. In the setup tools, go to Setup > System Options > Ports & Devices > RS-485.

AXISa AXIS 243Q Blade Video Server Live View | Setup | Help

» Basic Configuration COM Port RS485 0

. Port Settings
» ¥ideo & Image
Uszage

) i . Generic TCR/IP
» Live Yiew Config |Generic HTTP

» Event Configuration

-+ System Options
b Security
Date & Time
» Network
- Ports & Devices
I/0 Ports
RS485
Maintenance
» Support
v Advanced

About

3. Select Pan Tilt Zoom from the Usage drop-down list.

4. If you wish to configure PTZ on other video inputs, enter an Authentication key
to prevent unauthorized access to the RS-485 port. See also page 34.

5. Click Upload to install a PTZ driver.
(PTZ drivers are available from the Axis Web site at www.axis.com)

6. Click Port Options... to modify the port settings. The default values correspond to
the values specified by the PTZ driver.

7. From System Options > Ports & Devices, select the port configured for PTZ and
then select the video source to use with the device.

28



AXI1S 243Q Blade - Pan Tilt Zoom

8. If required, click the Advanced Options button to make further settings and see
the online help. €)

Note: Advanced users and application developers can also use the Axis Application Programming Interface and
HTTP specification for generic control of PTZ devices using CGI commands or a TCP/IP client. Please refer to
the Axis Website at www.axis.com for further information.

PTZ configuration
When PTZ has been installed for the AXIS 243Q Blade, the menu item PTZ Configuration
will appear in the menu to the left, along with its sub menus.

AXISa AXIS 243Q Blade Video Server Live View | Setup | Help

Preset Positions (2]

Preset Position Setup

» Basic Configuration

Vi
video & Image Current position:

b Live Yiew Config

+ PTZ Configuration [T Use current position as Home 4}
Preset Positions
Guard Tour #dd
» Advanced Available positions:
Q=D Menu lﬁ
Control Queue
Goto | Remove

» Event Configuration
» System Options

About

PAN  Left Right

ZOOM Wide Tele | ctr panel
FOCUS Near Far

IRIS  Close ©pen

Preset positions
Many PTZ devices provide Preset positions, which are pre-defined camera views than can
be used to quickly move the camera to a specific location.

From Preset Position Setup, use the Pan, Tilt and Zoom (PTZ) controls to steer the camera
to the required position. When satisfied with the camera’s position, enter a descriptive
name. The camera position, iris and focus settings are then saved as a preset position.

The position can be assumed at any time, by selecting the preset’s name from the Preset
positions drop-down list. Preset positions can be selected in Live View and by events.

One position can be set as the Home position, which is readily accessible by clicking in the
box beside Use current position as Home. The position’s name will then have (H) added to
the end, e.g. Office Entrance (H).
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PTZ controls

If the AXIS 243Q Blade has been appropriately configured, the Live View page will display
the controls available for the installed Pan Tilt Zoom (PTZ) device. The administrator can
enable/disable the controls for specified users.

ue Preset positions

AXISa AXIS 243Q Blade Video Server Live view | Setup | Help
wideo format Source
Motion JPEG 'I Video - Position 2 'I '\

= - N =

<«—Tilt bar (relative)

Flaying, Motion TFEG

000

PAN  Left Right

ZOOM Wide Tele | Ctrl panel
FOCUS Near Far

IRIS cClose Open

The exact controls shown depends on the make and model of PTZ device. There may be
e.g. Focus and Iris bars available as well, but the most common controls are;

¢ the Pan bar - moves the camera to the right and left

e the Tilt bar - tips the camera up and down

e the Zoom bar - zooms the view in and out. Note that this is only available if the
camera is fitted with a zoom lens.

e the Iris bar - adjusts the brightness of the image

Clicking on the bars themselves or on the arrows at the end of the bars will move the
camera to a new position. The type of movement and the location of this new position
depends on the type of PTZ driver.

When controlling the camera using a relative PTZ driver (see the bars in the illustration
above) the new position will be relative to the previous position, e.g. left of, below, above,
etc. Clicking the bar further from the center results in a larger movement.
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In contrast, when using an absolute driver, each
position on the bar (see right) represents a defined
position in the device’s range of movement, with the center of the bar representing the
point midway between the two extremes of movement.

Left Right

Clicking a position directly on the bar moves the camera directly to the new position in
one smooth movement. Clicking on the arrows at the ends of a bar causes a stepped,
incremental change.

Using CGI links to control PTZ devices

User-defined CGI links on the Live View page can be used to issue HTTP API requests, e.g.

PTZ commands. These links are configured in the Live View Layout settings, see page 9.

PTZ control modes
The PTZ device can also be controlled using click-in-image movement, which has two
different types of navigation; Center and Joystick.

Center mode means that when clicking in the image, the camera view will center on the
absolute position that was clicked.

Joystick mode moves the camera in the direction of the mouse pointer. By clicking and
holding the mouse button down in the image, the PTZ device moves the camera in that
direction, relative to the center of the image. The further from the center the image is
clicked, the greater the movement. The camera stops moving when the button is released.

Note: There is also joystick support in AXIS Media Control (AMC).

Control panel

The focus and iris (image brightness) can be adjusted manually by using the control bars,
or they can be set for automatic adjustment, by clicking the Auto iris and Auto focus
buttons.

To access the Auto iris and Auto focus buttons, click on the Control il panc
panel button. The menu to the right will then appear in the upper left S e
hand corner of the screen. o o
Auto iriz
There are also driver specific shortcuts that can appear in the Control e e
Panel. In the screen to the right, a driver has been installed that Driver spacific sharteuts

Wiper

brings up the Wiper shortcut button, which allows the user to
configure and use a windshield wiping action with the AXIS 243Q
Blade.

Mk
Close panel #Rp open
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Preset positions

Select presets from the drop-down Source list on the Live View page. These will move
and/or zoom the camera to a pre-defined position, i.e. to cover an area of particular
interest. Events can also be configured to go to preset positions when triggered. For
information on setting up preset positions, please see Preset positions, on page 29 and the
online help.

Guard tour

A guard tour moves between chosen Preset Positions, one-by-one, in a pre-determined
order or randomly, and for configurable time periods. A guard tour sequence will continue
to run after the user has logged off or closed the browser.

Advanced

Device Settings - The device settings window is for driver specific settings, so the
appearance of this window can vary depending on the driver installed. Options that can be
configured include: Driver Specific Settings for Video Source 1, Mechanical Limits for
Moving Video Source 1, Light Control for Video Source 1, and Extended Driver Specific
Settings for Video Source 1.

Ctrl Panel - The Panel View Settings window contains tools for creating and saving short
command buttons that are located under the Control panel. These buttons provide direct
access to various built-in auxiliary commands provided by the PTZ driver and are
displayed in the PTZ Panel.

Limits - Define the pan, tilt, zoom and focus limits for the AXIS 243Q Blade. Movements
to the left and right, up and down can be restricted to narrow the area under surveillance.
The near focus limit can be set to avoid focusing on objects too close to the camera.
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OSD Menu - If the PTZ unit supports an internal configuration menu, this can be accessed
using the On-Screen Display (OSD). Configure the analog camera by opening and
navigating through its internal menu in this display.

AXISa AXIS 243Q Blade Video Server Live view | Setup | Help

On-Screen Display Menu (2]

Video (Sensormatic Ultra 7}

» Basic Configuration

» ¥ideo & Image
Cpen

» Audio

wok SET UP MENU ok Clozs
» Live View Config PRESET 11 Back
MAP 3
~ PTZ Configuration HOME POSITION gelect
Praset Positions SELF RETURN F
Guard Tour AUTO MODE
T pbanced AUTO_PAN KEY
e DIGITAL FLIP
08D Menu LOCAL /REMOTE
Contral Queue SPECIAL1
CAMERA 1
» Event Configuration RS48S SET UP 1

» System Options

About PTZ Control Queue

Status in queve: [Hatin quene

Position in queue: Time remaining: seconds
Request control

PTZ control queue

Use the PTZ control queue window to enable and disable PTZ queueing. This window
allows you to set up a queue for viewers wanting to access the AXIS 243Q Blade, and
limits the number of viewers and the length of time each viewer can access and control the
PTZ unit. For more information on how to set up the control queue, please see the online

help. €)

AXISa AXIS 243Q Blade Video Server Live view | Setup | Help
PTZ Control Queue (9]

Control Queue Settings

+ Basic Configuration

} Yideo & Image
9 [T Enable BTZ contral queue

¢ Live Yiew Config Lirnit nurnber of users in queus ta: |20 [1..100]
v PTZ Configuration Contral queue polltime: 20 [5..3600]
Preset Positions Save — |
Guard Tour
v sdvanced
050 Menu

Control Queue
+ Event Configuration
b System Options

About

Note also that a viewer who belongs to a group (see Security, on page 35) with a higher
PTZ priority can go before other users in the queue and take control of the AXIS 243Q
Blade.
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The order of priority for taking control of the queue is as follows:

1.

Administrators - An administrator takes over PTZ control regardless of who is
currently first in queue. The administrator will be removed from the queue 60
seconds after their last PTZ control command.

Event - The AXIS 243Q Blade can be set up to take control of the queue and
move to a specific position for 20 seconds when triggered by an alarm. The event
will immediately be placed first in the queue, except when an administrator is in
control. For more information, see Triggered Event, on page 24.

3. Operator - Same as administrator, but with lower priority.

Guard Tour - A guard tour has PTZ control for an indefinite period of time. It
may be overridden by; Operator, Event or administrator. Guard Tour will resume
when higher priority groups leave the queue. For more information see Guard
tour, on page 32.

Viewer - Multiple viewers must wait for their turn. The viewer has 60 seconds
PTZ control before control is passed to the next viewer in queue.

Note: In order to identify different users in the viewer group, cookies must be enabled on the client.

Using PTZ on video inputs 2-4

Although the AXIS 243Q Blade supports an RS-485 port on video input 1 only, it is still
possible to use PTZ devices on video inputs 2-4 by creating virtual connections to these
inputs from video 1. To do this, follow these steps:

1. Configure PTZ on video input 1 and install the required PTZ driver. This step is

always required, whichever video input you intend to use for PTZ, and is
described in detail in Installing PTZ devices, on page 28.

2. Repeat this procedure and install the same device driver on the other video

input(s) you wish to use PTZ on.

3. Enter the same Authentication key as configured for video input 1. This will

prevent unauthorized access to the RS-485 port.

PTZ devices on inputs 2-4 are configured in the same way as a device on video input 1.
See page 29 for information on configuration.
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System options

Security

User access control is enabled by default, when the administrator sets the root password on
first access. New users are authorized with user names and passwords, or the administrator
can choose to allow anonymous viewer login to the Live View page, as described below:

Users - the user list displays the authorized users and access levels:

Viewer Provides the lowest level of access, which only allows the user access to the Live View page

Operator An Operator can view the Live View page, create and modify event types and adjust certain other
settings. The Operator does not have access to the Systems Options configuration pages.

Administrator | An administrator has unrestricted access to the Setup Tools and can determine the registration of all
other users.

User settings - check the corresponding checkboxes to enable:

¢ Anonymous viewer login - allows any viewer direct access to the Live View
page.

e Anonymous PTZ control login - allows any viewer access to the Pan Tilt Zoom
controls on the Live View page (if Pan/Tilt/Zoom is available).

IP address filtering

Checking the Enable IP address filtering box enables the IP address filtering function. Up
to 256 IP address entries may be specified (a single entry can contain multiple IP
addresses). Click the Add button to add new filtered addresses.

When the IP address filter is enabled, addresses added to the list are set as allowed or
denied addresses. All other IP addresses not in this list will then be allowed or denied
access accordingly, i.e. if the addresses in the list are allowed, then all others are denied
access, and vice versa. See also the online help for more information.

Note that users from IP addresses that will be allowed must also be registered with the
appropriate access rights (User, Operator or Administrator). This is done from Setup >
System Options > Security > Users.

Referrals - to prevent unauthorized sources from including the video stream from the
AXIS 243Q Blade into external Web pages, check the Referrals box and enter the IP
address or Host name of the computer that hosts the Web pages with the included video
stream. Multiple IP addresses/host names can be defined and are separated by semicolons(;)
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Notes: elf the referrals feature is enabled and you wish to also allow normal access to the Live View
page, the product's own IP address or host name must be added to the list of allowed referrers.

®Restricting referrers has no effect on an MPEG-4 video stream. To restrict an MPEG-4 stream, [P
address filtering must be enabled.

®Restricting referrers is of greatest value when not using IP address filtering. If IP address filter-
ing is used, then the allowed referrers are automatically restricted to those allowed IP
addresses.

HTTPS

For greater security, the AXIS 243Q Blade can be configured to use HTTPS (Hypertext
Transfer Protocol over SSL (Secure Socket Layer)). That is, all communication that would
otherwise go via HTTP will instead go via an encrypted HTTPS connection.

Certificate - to use HTTPS for communication with the AXIS 243Q Blade, a Certificate
must be created using one of these methods:

e A self-signed certificate can be created in the video server, but this does not guar-
antee the same level of security as an official certificate.

* An official certificate issued by a CA (Certificate Authority). A CA issues and
manages security credentials and public keys for message encryption.

1. Click either Create self-signed certificate or Create Certificate Request and enter
the required information in the provided fields

2. Click OK.

3. Create self-signed certificate generates and installs a certificate which will be
displayed under Installed Certificate.
Create Certificate Request generates a PEM formatted request which you copy
and send to a CA for signing. When the signed certificate is returned, click Install
signed certificate... to install the certificate in the AXIS 243Q Blade.

4. Set the HTTPS Connection Policy for the administrator, Operator and Viewer to
enable HTTPS connection (set to HTTP by default)

Please refer to the home page of your preferred CA for information on where to send the
request etc. For more information, please see the online help €)
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802.1x - Network Admission Control

IEEE 802.1x is an IEEE standard for port-based Network Admission Control. It provides
authentication to devices attached to a network port (wired or wireless), establishing a
point-to-point connection, or, if authentication fails, preventing access on that port.
802.1x is based on EAP (Extensible Authentication Protocol).

In a 802.1x enabled network switch, clients equipped with the correct software can be
authenticated and allowed or denied network access at the Ethernet level.

Clients and servers in an 802.1x network may need to authenticate each other by some
means. In the Axis implementation this is done with the help of digital certificates
provided by a Certification Authority. These are then validated by a third-party entity,
such as a RADIUS server, examples of which are Free Radius and Microsoft Internet
Authentication Service.

To perform the authentication, the RADIUS server uses various EAP methods/protocols, of
which there are many. The one used in the Axis implementation is EAP-TLS
(EAP-Transport Layer Security).

The AXIS network video device presents its certificate to the network switch, which in turn
forwards this to the RADIUS server. The RADIUS server validates or rejects the certificate
and responds to the switch, and sends its own certificate to the client for validation. The
switch then allows or denies network access accordingly, on a preconfigured port.
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The authentication process

Axis video device ‘\

E 7 Certificate
@ Q: Certificate OK? @
A: OK
¥ : Certificate OK?
Network | & oo HHeate
switch
@ Certificate
Authority (CA)
Sewely 5 Certificate

Protected network

1. A CA server provides the required signed certificates.

2. The Axis video device requests access to the protected network at the network switch.
The switch forwards the video device’s CA certificate to the RADIUS server, which then

replies to the switch.

3. The switch forwards the RADIUS server’s CA certificate to the video device, which
also replies to the switch.

4. The switch keeps track of all responses to the validation requests. If all certificates are
validated, the Axis video device is allowed access to the protected network via a

preconfigured port.

RADIUS
RADIUS (Remote Authentication Dial In User Service) is an AAA (Authentication,

Authorization and Accounting) protocol for applications such as network access or IP
mobility. It is intended to work in both local and roaming situations.

CA servers
In cryptography, a Certification Authority (CA) is an entity that provides signed digital

certificates for use by other parties, and thus acts a trusted third party.

There are many commercial CA’s that charge for their services. Institutions and
governments may have their own CA, and there are free CA’s available.
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Date & time

Current server time - displays the current date and time (24h clock). The time can be
displayed in 12h clock format in overlay images.

New server time - Select your time zone from the drop-down list and check the daylight
saving time changes, if desired.

From the Time Mode section, select the preferred method to use for setting the time:

¢ Synchronize with computer time - sets the time from the clock on your com-
puter.

¢ Synchronize with NTP Server - the video server will obtain the time from an
NTP server every 60 minutes. Specify the NTP server’s I[P address or host name.

Note: Note that if using a host name for the NTP server, a DNS server must be configured under TCP/IP settings.
See Network > Advanced TCP/IP Settings below.

e Set manually - this option allows you to manually set the time and date.

Date & time format used in images - specify the formats for the date and time (12h or
24h) displayed in the Live View video streams.

Use the predefined formats or use your own custom date and time formats. See File
Naming & Date/Time Formats in the online help €) for information on how to create
your own date and time formats.
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Network - Basic TCP/IP settings

IP Address Configuration

The AXIS 243Q Blade supports both IP version 4 and IP version 6. Both versions may be
enabled simultaneously, and at least one version must always be enabled.

When using IPv4, the IP address can be set automatically via DHCP, or a static IP address
can be set manually.

If IPv6 is enabled, your camera will receive an IP address according to the configuration in
the network router.

There are also options for setting up notification of changes in the IP address, and for
using the AXIS Internet Dynamic DNS Service. For more information on setting the IP
address, please see the online help.

Notes:

® DHCP is a protocol for automatic IP address assignment on a network. IP address assignment via DHCP may
lead to the situation where the IP address changes and you lose contact with the camera. Configure the
options for notification of IP address change (under Services) to receive notification from the camera when
the IP address changes.

o Alternatively, if your DHCP server can update a DNS server, you can access the AXIS 243Q Blade by host
name which is always the same, regardless of the IP address.

Services

Enable ARP/Ping setting of IP address - The IP address can be set using the ARP/Ping
method, which associates the unit’s MAC address with an IP address. Check this box to
enable the service. Leave disabled to prevent unintentional resetting of the IP address.

Notes: e The ARP/Ping service is automatically disabled 2 minutes after the unit is started, or as soon as an IP address
is set.
® Pinging the unit will still be possible when this service is disabled.

AXIS Internet Dynamic DNS Service - If the AXIS 243Q Blade has been registered with
the Axis Internet Dynamic DNS service and the IP address for the product changes, the
service is updated to reflect the change. Check the box to enable/disable automatic
updates.

The domain name currently registered at the Axis Internet Dynamic DNS service for your
product can at any time be removed. To do this click Settings... and follow the
instructions. For more information, please refer to the online help €)
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Network - Advanced TCP/IP settings

DNS configuration
DNS (Domain Name Service) provides the translation of host names to IP addresses on your
network.

Obtain DNS server address via DHCP - automatically use the DNS server settings provided
by the DHCP server. Click the View button to see the current settings.

Use the following DNS server address - enter the desired DNS server by specifying the
following:

Domain name - enter the domain(s) to search for the host name used by the AXIS 243Q
Blade. Multiple domains can be separated by semicolons (;). The host name is always the
first part of a Fully Qualified Domain Name, e.g. myserver is the host name in the Fully
Qualified Domain Name myserver.mycompany.com where mycompany.com is the
Domain name.

DNS servers - enter the IP addresses of the primary and secondary DNS servers.

NTP
Obtain NTP server address via DHCP - use a DHCP server to automatically find an NTP
server to synchronize clock of the AXIS 243Q Blade with the other devices on the network

Use the following NTP server address - use the host name or IP address of a specific NTP
server for time synchronization.

Host name configuration
The AXIS 243Q Blade can be accessed using a host name, instead of an IP address. The
host name is usually the same as the assigned DNS Name.

For more information, please see the online help €)

Link-Local address

This is enabled by default and assigns the AXIS 243Q Blade an additional IP address for
use with UPnP™. The AXIS 243Q Blade can have both a Link-Local IP and a static or
DHCP-supplied IP address at the same time - these will not affect each other.

HTTP
The default HTTP port number (80) can be changed to any port within the range
1024-65535. This is useful for e.g. simple port mapping.
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HTTPS
The default HTTPS port number (443) can be changed to any port within the range
1024-65535. This is useful for e.g. simple port mapping.

NAT traversal
Use NAT traversal when your video server is located on an intranet and you want to make
it available from the other side of a NAT router.

FTP
The FTP server running in the AXIS 243Q Blade enables the upload of e.g. new firmware,
user applications, etc. Check the box to enable the service.

RTSP

The RTSP protocol allows a connecting client to start an MPEG-4 stream. Check the box to
enable the RTSP server and enter the RTSP port number to use. The default setting is 554,
and the allowed port range is 1024-65535. Note that MPEG-4 streams will not be available
if this is not enabled.

Network traffic

The default setting is Auto-negotiate which means that the correct speed is automatically
selected. If necessary, you can set the connection speed by selecting it from the drop-down
list.

Maximum bandwidth - Specify, in Mbit/s or kbit/s, the maximum bandwidth that the
video server is allowed to use on your network. This is a useful function when connecting
your video server to busy or heavily loaded networks. The default setting is Unlimited.

Note: When using MPEG-4 as the video format, remember that setting a maximum bandwidth value here may
create problems for individual video streams if the maximum value is less than the sum of the bit rates set
for the video streams.

For more information, please see the online help €)

SOCKS

SOCKS is a networking proxy protocol. The AXIS 243Q Blade can be configured to use a
SOCKS server to reach networks on the other side of a firewall/proxy server. This
functionality is useful if the video server is located on a local network behind a firewall,
but notifications, uploads, alarms, etc., need to be sent to a destination outside the local
network (e.g. to the Internet).
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QoS (Quality of service)

Quality of Service (QoS) provides the means to guarantee a certain level of a specified
resource to selected traffic on a network. Quality can be defined as e.g. a maintained level
of bandwidth, low latency, no packet losses, etc. The main benefits of a QoS-aware
network can be summarized as:

e The ability to prioritize traffic and thus allow critical flows to be served before
flows with lesser priority.

¢ QGreater reliability in the network, thanks to the control of the amount of band-
width an application may use, and thus control over bandwidth races between
applications.

The QoS in Axis network video products marks the data packets for various types of
network traffic originating from the product. This makes it possible for network routers
and switches to e.g. reserve a fixed amount of bandwidth for these types of traffic. The
following types of traffic are marked:

e live video

¢ live audio

e event/alarm traffic

¢ management network traffic.

QoS Settings

For each type of network traffic supported by your Axis network video product, enter a
DSCP (Differentiated Services Codepoint) value. This value is used to mark the traffic’s IP
header. When the marked traffic reaches a network router or switch, the DSCP value in the
IP header tells the router or switch which type of treatment to apply to this type of traffic,
for example, how much bandwidth to reserve for it.

Note that DSCP values can be entered in decimal or hex form, but saved values are always
shown in decimal.

For more infomation on Quality of Service, please see the Axis support web at
www.axis.com/techsup

SMTP (email)

Enter the host names or addresses for your primary and secondary mail servers in the fields
provided, to enable event and error email messages from the video server to predefined
addresses, via SMTP.

If the mail server requires SMTP authentication, check the box for Use authentication to
log in to this server and enter the user name and password used for logging in. Several
different methods of authentication are available. See the online help for more
information.
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SNMP

The Simple Network Management Protocol (SNMP) allows the remote management of
network devices. Select the version of SNMP to use, depending on the level of security
required. Select the version of SNMP to use, by checking the appropriate box. The three
levels of security are:

e SNMP V1 - includes no security
e SNMP V2c - uses very simple security, e.g. community name as password
e SNMP V3 - provides encryption and secure passwords. Use with HTTPS.

If using V1 and V2c, enter the community name for read-only access to all supported
SNMP objects (except the root password and other objects that require write access).
Default value = public. You can also specify the community name for read/write access to
all supported SNMP objects (except read-only objects). Default value = pass.

If using HTTPS enter the password if it has not already been set. To set the password again,
the AXIS 243Q Blade must be reset to the factory default settings.

UPnP™

The video server includes support for UPnP™ in Windows ME and Windows XP. UPnP™ is
enabled by default.

Note: UPnP™ must be installed on your workstation if running Windows XP. To do this, open the Control Panel
from the Start Menu and select Add/Remove Programs. Select Add/Remove Windows Components and
open the Networking Services section. Click Details and then select UPnP™ as the service to add.

RTP /| MPEG-4

These settings are the IP address, port number, and Time-To-Live value to use for the
media stream(s) in multicast MPEG-4 format. Only certain IP addresses and port numbers
should be used for multicast streams. For more information, please see the online help. €)

Bonjour
The AXIS 243Q Blade includes support for Bonjour. When enabled, the video server is
automatically detected by operating systems and clients that support this protocol.

Ports €t devices

I/0 Ports - the pinout, interface support and control and monitoring functions provided by
this connector are described in I/0 Terminal connector, on page 48.

RS485 - The COM port on the AXIS 243Q Blade supports several operational modes. For
more information, please see RS-485 COM port, on page 49.
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Maintenance

Restart - The video server is restarted without changing any of the settings. Use this
method if the unit is not behaving as expected.

Restore - The video server is restarted and most current settings are reset to factory
default values. The settings that are not affected are:

e the boot protocol (DHCP or static)
e the static IP address

¢ the default router

e the subnet mask

¢ the system time

Default - The default button should be used with caution. Pressing this will return all of
the video server’s settings to the factory default values (including the IP address)
Upgrade Server - See Upgrading the firmware, on page 50.

Backup - To take a backup of all of the parameters, and any user-defined scripts, click
this button. If necessary, it is then possible to return to a previous configuration if set-
tings are changed and there is unexpected behavior.

Restore - click the Browse button to locate the saved backup file (see above) and then
click the Restore button. The settings will be restored to the previous configuration.

Note: Backup and Restore can only be used on the same unit running the same firmware. This feature is not

intended for multi-configurations or for firmware upgrades.
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Support

The support overview page provides valuable information on troubleshooting and contact
information, should you require technical assistance.

The System Overview provides a summary of the status of the video server.

Logs & Reports - when contacting Axis support, please be sure to provide a valid Server
Report with your query.

Information - The Log report and the Parameter List also provide valuable information for
troubleshooting and when contacting Axis support service.

Configuration:

Log Level for Log Files - from the drop-down list, select the level of information to be
added to the Log file

Log Level for Email - from the drop-down list, select the level of information to send as
email and enter the destination email address.

Advanced

Scripting is an advanced function that provides the possibility to customize and use
scripts. This function is a very powerful tool.

Caution!

Improper use may cause unexpected behavior or even cause loss of contact with the
unit. If a script does cause problems, reset the unit to its factory default settings. A
backup file may be of use to return the unit to its latest configuration).

Axis strongly recommends that you do not use this function unless you fully
understand the consequences. Note that Axis support does not provide assistance for
problems with customized scripts.

For more information, please visit the Developer pages at www.axis.com/developer

Plain Config - this function is for the advanced user with experience of Axis video
server configuration. All parameters can be set and modified from this page,
including the audio encoding format. Help is available from the standard help pages.
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Resetting to the factory default settings

This will reset all the parameters in all 4 units (including all four IP addresses) to the
factory default settings.

1. Disconnect power.
2. Press and hold the Control button and reconnect power.

3. Release the button when the
Status Indicator displays red (this
may take up to 15 seconds). When
the Status Indicator changes to
Green (may take up to 1 minute),
the process is complete and the
AXIS 243Q Blade has been reset.

4. Re-assign the IP addresses, using
one of the methods described in
this document.

Control button

To reset an individual unit to the original factory default settings, use the button provided
in that unit’s web interface. For more information, please see the online help.
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1/0 Terminal connector

The inputs and outputs on the AXIS 243Q Blade are accessed via the 12-pin I/O terminal
connector on the AXIS 291 1U Video Server Rack. The following are available:

e 4 digital transistor outputs (1 per video input)

e 4 digital inputs (1 per video input)

e RS-485 interface (AXIS 243Q(1) Blade only)

e auxiliary power and GND

The terminal connector is used in applications for e.g. motion detection, event triggering,
time lapse recording, alarm notification via email, image storage to FIP locations, etc.

¢ Inputs - used for e.g. a push button. If the button is pressed, the state changes,
and the input will be active (shown under Event Configuration > Port Status).

¢ Qutputs - e.g. an alarm device that can be activated from Output buttons on the
Live View page or as an action to an Event Type. The output will show as active
(in Event Configuration > Port Status), if the device is activated.

Pin Function Description
1 +12V DC Power output This pin can be used to power auxiliary equipment, 12V DC max 100mA per
blade.

2 GND

3 Input 1 (Video input 1) Connect to GND to activate or leave floating (or unconnected) to deactivate.

4 Input 2 (Video input 2)

5 Input 3 (Video input 3)

6 Input 4 (Video input 4)

7 Output 1 (Video input 1) With a maximum load of 100mA and maximum voltage of 24V DC, the output

F) Output 2 (Video input 2) has an open-collector NPN transistor with the emitter connected to pin 2

9 Output 3 (Video input 3) (GND). If i't is to be used with an .extema.l relay, a diode must b.e connected in

: : parallel with the load for protection against any voltage transients.

10 Output 4 (Video input 4)

1 RS-485-A (non-inverting) A half-duplex RS-485 interface for controlling auxiliary equipment, e g. PTZ
(Video input 1) devices. This is available on AXIS 243Q(1) Blade only.

12 RS-485-B (inverting)
(Video input 1)

The AXIS 291 Video Server rack includes a green 12-pin connector block. Connect
input/output devices to this block:

1. Loosen the corresponding screw on top of the pin on the connector block (see the
table above to determine which pin to use).

2. Push the cable into the connector block and secure it by fastening the screw.

3. Once all devices are connected, connect the connector block to the video server’s
terminal connector.
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Schematic diagram - 1/0 terminal connector

+12V Out (100mA)

Relay

Device

e.g. pushbutton

RS-485 COM port
The RS-485 COM Port supports several operational modes:

e Generic TCP/IP - enables the video server to receive status/data and send com-
mands via TCP/IP

e Generic HTTP - enables the video server to receive status/data and send com-
mands via HTTP

e Pan Tilt Zoom (PTZ) - for controlling a PTZ device. A PTZ device requires a driver
for its function. Drivers can be obtained from www.axis.com. Please see page 28
for information on how to connect PTZ devices.
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Troubleshooting

Checking the firmware

Firmware is software that determines the functionality of the AXIS 243Q Blade. One of
your first actions when troubleshooting a problem should be to check the currently
installed version. The latest version may contain a correction that fixes your particular
problem. The current firmware version in your AXIS 243Q Blade can be seen under Setup
> Basic Configuration.

Important!

Please note that the AXIS 243Q Blade uses two different firmware types at the same time. The first of these
is intended for video input 1, which includes features not supported by the other inputs (2,3, and 4). Please
check that the correct firmware is loaded to the correct unit.

Upgrading the firmware

When you download firmware from the Axis Web site, your Axis product will receive the
latest available functionality. Always read the upgrade instructions and release notes
available with each new release, before updating the firmware.

New firmware can be downloaded to the AXIS 243Q Blade over the network.

Note: Pre-configured and customized settings will be retained for use after the new firmware is installed (pro-
vided the features are available in the new firmware) although this is not guaranteed by Axis Communica-
tions.

1. Save the firmware file to your computer. The latest versions of the firmware files
for the AXIS 243Q Blade are available free of charge from the Axis Web site at
www.axis.com/techsup

2. Go to Setup > System Options > Maintenance in the video server’s Web pages.

3. In the Upgrade Server section and browse to the desired firmware file on your
computer. Click Upgrade.

Upgrade Server
Upgrade the AXIS 243Q(1) Blade with the latest firmware,

Specify the firmware to upgrade to: I Browse. .. I and click Upgrade |

Note: Do not disconnect power to the unit during the upgrade. The unit restarts autormatically
after the upgrade has completed, (1-10 rminutes.]
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Notes: eAlways read the upgrade instructions available with each new release, before updating the firm-
ware.

e After starting the process, you should always wait at least 20 minutes before restarting the AXIS
243Q Blade, even if you suspect the procedure has failed.

*Your dealer reserves the right to charge for any repair attributable to faulty updating by the
user.

Emergency recovery procedure

If power or the network connection to the AXIS 243Q Blade is lost during the upgrade, the
process will fail and the unit will become unresponsive. A red Status LED indicates a failed
upgrade. To recover the unit, follow the steps below. The serial number can be found on
the label supplied with the product.

1. Unix/Linux - From the command line, type the following:
arp -s <IP address of AXIS 243Q Blade> <Serial number> temp
ping -s 408 <IP address of AXIS 243(Q Blade>

Windows - From a command/DOS prompt, type the following:
arp -s <IP address of AXIS 243Q Blade> <Serial number>
ping -1 408 -t <IP address of AXIS 243Q Blade>

2. If the unit does not reply within a few seconds, restart it and wait for a reply. Press
CTRL+C to stop Ping.

3. Open a web browser and type in the AXIS 243Q Blade’s IP address. In the page that
appears, use the Browse button to select the upgrade file to use, e.g. axis243q.bin.
Then click the Load button to restart the upgrade process.

4. After the upgrade has completed (1-10 minutes), the unit will automatically restart and
show a steady green on the Power and Status LEDs, and a green flash on the Network
LED.

5. Reinstall the AXIS 243Q Blade.

If the emergency recovery procedure does not get the AXIS 243Q Blade up and running
again, please contact Axis support at www.axis.com/techsup/
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Support

If you contact Axis support, please help us help you resolve your problems expediently by
providing a server report, log file and a brief description of the problem.

Server Report - Click the link provided on the page at Setup > System Options > Support
> Support Overview. The report contains important information about the server and its
software, as well as a list of the current parameters.

Log file - Go to Setup > System Options > Support > Logs & Reports. The Log file records
events within the unit since the last restart of the system and can prove a useful diagnostic
tool for troubleshooting.



AXIS 243Q Blade - Troubleshooting

Symptoms, Possible Causes and Remedial Actions

Problems setting the IP address

Using ARP/Ping - the IP address Restart the server and try again. Ensure also the ping length is set to 408. (See the AXIS 243Q

must be set within two minutes Blade Installation Guide)

after power has been applied to

the video server

The video server is located on a  If the IP address intended for the AXIS 243Q Blade and the IP address of your computer are

different subnet. located on different subnets, you will not be able to set the IP address. Contact your network
administrator for an IP address on the same subnet as the computer you are performing the
installation from.

The IP address is being used by  Disconnect power from the AXIS 243Q Blade.

another device Run the Ping command (in a Command/DOS window, type ping <IP address of unit>

If you receive: Reply from <IP address>: bytes = 32; time = 10 ms..... - this means that the IP
address may already be in use by another device on your network. You must obtain a new IP
address and reinstall the unit.

If you receive: Request timed out - this means that the IP address is available for use with your
video server. In this case, check all cabling and reinstall the unit.
The AXIS 243Q Blade cannot be accessed from a web browser
Cannot log in If the AXIS 243Q Blade has been configured to use HTTPS, check that the protocol in the URL
used to access the unit is correct. You may need to type this in manually (i.e. http or https) in
the browser's address field.
The IP address has been changed 1) Move the AXIS 243Q Blade to an isolated network or to one with no DHCP or BOOTP server.
by DHCP Set the IP address again, using the ARP Ping command.
2) Access the unit and disable BOOTP and DHCP in the TCP/IP settings. Return the unit to the
main network. The unit now has a fixed IP address that will not change.
3) As an alternative to 2), if dynamic IP address via DHCP or BOOTP is required, select the
required service and then configure IP address change notification from the network settings.
Return the unit to the main network. The unit will now have a dynamic IP address, but will
notify you if the address changes.
Other networking problems Test the network cable by connecting it to another network device, then Ping that device from
your workstation. See instructions above.
Cannot send notifications, uploads, alarms, etc, to a destination outside the local network
Firewall protection The video server can be configured to use a SOCKS server to reach networks on the other side
of a firewall/proxy server
Your AXIS 243Q Blade is accessible locally, but not externally
Firewall protection Check the Internet firewall with your system administrator.
Default routers required Check if you need to configure the default router settings.
The Internet site is too heavily ~ Use a script on your web server to relay images from the AXIS 243Q Blade to the Internet.
loaded
The Status indicator shows red and the server is inaccessible
A firmware upgrade has been A rescue firmware is running in the product. First, set the IP address using AXIS IP utility or ARP
interrupted or the firmware has and Ping, (See the AXIS 243Q Blade Installation Guide). Then, using a web browser, access the

been damaged in some other unit and download the latest firmware to the product, see Upgrading the firmware, on page 50.

way.
No images displayed in the Web interface
Problem with AMC To enable the updating of images in Microsoft Internet Explorer, set your browser to allow
(Internet Explorer only) ActiveX controls. Also, make sure that AXIS Media Control (AMC) component is installed on
your workstation.
Installation of additional ActiveX Configure your AXIS 243Q Blade to use a Java applet for updating the images under
component restricted or prohib- Live View Config > Layout > Default Viewer for Internet Explorer. See the online help for more
ited information.

Video Image Problems
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Image too dark or too light. Check that the termination dip switch for the video source is set to the correct position. See
also the online help on Video Source Settings

Black borders around the video  Adjust the X and/or Y offset, in the Video Source Settings. See the online help for information.

image

Problems uploading own files There is only limited space available for the upload of your own files. Try deleting one or more
existing files, to free up space

Missing images in uploads This can occur when trying to use a larger image buffer than is actually available. Try lowering
the frame rate or the upload period.

Slow image update Configuring e.g. pre-buffers, motion detection, high resolution images, high frame rates, etc.,
will reduce the performance of the video server.

Slow performance Slow performance may be caused by e.g. heavy network traffic, multiple users accessing the
unit, low performance clients, use of features such as Motion Detection, Event handling, Image
rotation.

Bad snapshot images

Display incorrectly configured on In Display Properties, configure your display to show at least 65000 colors, i.e. at least 16-bit.

your workstation Using only 16 or 256 colors on your display will produce dithering artifacts in the image.

Incorrect exposure in images

Incorrect line termination If the AXIS 243Q Blade is to be connected in loop through with other equipment, disable the
input termination by turning the corresponding DIP switch to OFF.

Problems with the MPEG-4 format

Lower frame rate than expected. Check with the administrator that there is enough bandwidth available. Check also the settings
for bit rate control, in the Video & Image > Advanced > MPEG-4 settings. Using an inappro-
priate video object type can also affect the frame rate. See the online help for more informa-
tion.

Check in the AMC control panel applet (MPEG-4 tab) that video processing is not set to Decode
only | frames.

Lower the image resolution.

Reduce the number of applications running on the client computer.
No MPEG-4 displayed in the Check that the correct network interface is selected in the AMC control panel applet (network
client. tab).
Check that the relevant MPEG-4 connection methods are enabled in the AMC control panel
applet (network tab).

In the AMC control applet, select the MPEG-4 tab and click the button Set to default MPEG-4
decoder.

No multicast MPEG-4 displayed Check with your network administrator that the multicast addresses used by the
in the client. AXIS 243Q Blade are valid for your network.

Check with your network administrator to see if there is a firewall preventing viewing.
Multicast MPEG-4 only accessi- Check if your router supports multicasting, or if the router settings between the client and the

ble by local clients. server need to be configured. The TTL (Time To Live) value may need to be increased.
Poor rendering of MPEG-4 Color depth set incorrectly on clients. Set to 16-bit or 32-bit color.
images. If text overlays are blurred, or if there are other rendering problems, you may need to enable

Advanced Video Rendering. This is done on the MPEG-4 tab in the AMC control panel applet.

Ensure that your graphics card is using the latest device driver. The latest drivers can usually be
downloaded from the manufacturer's web site.

Color saturation is different in ~ Modify the settings for your graphics adapter. Please see the adapter's documentation for more
MPEG-4 and Motion JPEG. information.

For further assistance, please contact your reseller or check the product’s support pages on
the Axis Website at www.axis.com/techsup
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Technical specifications

Item

Specification

Video compression

® Motion JPEG
® MPEG-4 Part 2 (ISO/IEC 14496-2)
® Profiles: ASP and SP

Resolutions  4CIF, 2CIFExp, 2CIF, CIF, QCIF

® Max 704x480 (NTSC), 704x576 (PAL)

e Min 160x120 (NTSC), 176x144 (PAL)
Frame rate e Up to 30/25 per channel in all resolutions
(NTSC/PAL) (Motion JPEG or MPEG-4)

Video streaming

e Simultaneous Motion JPEG and MPEG-4
e Controllable frame rate and bandwidth
¢ Constant and variable bit rate (MIPEG-4)

Image settings

e Compression levels: 11 (Motion JPEG) /23 (MPEG-4)

® Rotation: 90°, 180°, 270°

® Aspect ratio correction

e Color: color, black & white

® Overlay capabilities: time, date, text, image, privacy mask
® De-interlace filter

Pan/Tilt/Zoom

* A wide range of analog PTZ dome cameras is supported, drivers available free of
charge at www.axis.com

® 20 presets/camera

® Guard tour

® PTZ control queue

® Supports Windows compatible joysticks

Security

® Multiple user access levels with password protection
e |P address filtering

® HTTPS encryption

e |EEE 802.1X authentication

Alarm and event
management

® Events triggered by video motion detection, external inputs or according to a
schedule,

® Image upload over FTP, Email, and HTTP

¢ Notification over TCP, Email, HTTP and external outputs

® Pre- and post alarm buffer of 9 MB per channel (approx. 4 min CIF resolution video
at 4 frames per second)

Connectors

¢ 4 BNC Analog composite video inputs, NTSC/PAL autosensing

Via AXIS 291 Video Server Rack:
e Ethernet 10BaseT/100BaseTX/1000BaseTX (Gigabit Ethernet)
® 4 alarm inputs (1 per video input)
® 4 alarm outputs (1 per video input)
® RS-485/422 half-duplex port (Video input 1 only)
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Item

Specification

Processors and memory

¢ CPU: 4 x ETRAX 100LX 32bit

® Video processing and compression: 4 x ARTPEC-2
* RAM: 4 x 32 MB

® Flash: 4 x 8 MB

® Battery backed up real-time clock

Operating conditions

® 0°-45°C (32-113 °F)
® Humidity 20-80% RH (non-condensing)

Installation, management
and maintenance

¢ AXIS Camera Management tool on CD and web-based configuration
® Configuration of backup and restore
® Firmware upgrades over HTTP or FTP, firmware available at www.axis.com

Video access from web
browser

e Camera live view for up to 20 clients (per video input)
® Video recording to file (ASF)

® Sequence tour for up to 20 PTZ presets

e Customizable HTML pages

Minimum Web browsing
requirements

® Pentium Il CPU 500 MHz or higher, or equivalent AMD
* 128 MB RAM

® AGP graphic card, Direct Draw, 32 MB RAM

® Windows XP, 2000,

® DirectX 9.0 or later

® Internet Explorer 6.x or later

For other operating systems and browsers see www.axis.com/techsup

System integration
support

® Open API for application integration, including AXIS VAPIX API*, AXIS Media Control
SDK*, event trigger data in video stream

e Quality of Service (QoS) Layer 3, DiffServ Model

® Watchdog ensures continuous operation, event notifications can be monitored by
other systems

® Embedded Linux operating system

* Available at www.axis.com

Supported protocols

IPv4/v6, HTTP, HTTPS, SSL/TLS*, TCP, QoS, SNMPv1/v2c/v3 (MIB-II), RTSP, RTP, UDP,
IGMP, RTCP, SMTP, FTP, ICMP DHCP, UPnP, Bonjour, ARP, DNS, DynDNS, SOCKS,
IEEE802.1X. More information on protocol usage available at www.axis.com

*This product includes software developed by the Open SSL Project for use in the
Open SSL Tool kit (www.openssl.org)

Included accessories

® |nstallation Guide,

® CD with installation and management tools, software and User's Manual,
* MPEG-4 licenses (1 encoder, 1 decoder),

* MPEG-4 decoder (Windows)

Applications (not
included)

e AXIS Camera Station - Surveillance application for viewing, recording and archiving
up to 25 cameras

See www.axis.com/partner/adp_partners.htm for further software applications from

partners
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Item Specification
Approvals * EN 61000-6-1,

* EN 61000-6-2,

® EN 55024

e EN 55022 Class B

¢ EN 61000-3-2,

* EN 61000-3-3,

® FCC Part 15 Subpart B Class B,
e AS/NZS CISPR 22

¢ |CES-003

e \/CCI Class B, ITE

* EN 60950-1

Dimensions (HxWxD) and
weight

® 30 x 130 x 255 mm (1.2" x 5.1" x 10.0")
* 270g (0.6 b)
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General performance considerations

When setting up your system, it is important to consider how various settings and
situations will affect performance. Some factors affect the amount of bandwidth (the bit
rate) required, others can affect the frame rate, and some will affect both. If the load on the
CPU reaches its maximum, this will also affect the frame rate.

The following factors are among the most important to consider:
e High image resolutions and/or lower compression levels result in larger images.

Bandwidth affected.

e Access by large numbers of Motion JPEG and/or unicast MPEG-4 clients. Band-
width affected.

e Simultaneous viewing of different streams (resolution, compression, etc.) by dif-
ferent clients. Frame rate and bandwidth affected.

¢ Accessing both Motion JPEG and MPEG-4 video streams simultaneously. Frame
rate and bandwidth affected.

e Heavy usage of event settings affects the CPU load. Frame rate affected.
¢ FEnabled motion detection. Frame rate and bandwidth affected.
e Heavy network utilization due to poor infrastructure. Bandwidth affected

e Viewing on poorly performing client PC lowers perceived performance. Frame
rate affected.

Optimizing your system

To see the bandwidth and frame rate currently required by the video stream, the AXIS
243Q Blade provides a tool that can be used to display these values directly in the video
image.

To do this, special format strings are added as part

of a text overlay. Simply add #r (average frame Text Overlay Settings

rate in fps) and/or #b (average bandwidth in Kbps) ~ [ mneud= date [ 1nduds time
to the overlay. Include text: |#r #b
Plare text/date/timme at | top | of image

For detailed instructions, please see the online help
for Video & Image > Overlay Settings, and the
help for File Naming & Date/Time Formats.

Important!

oThe figures displayed here are the values as delivered by the server. If other restrictions are
currently in force, (e.g. bandwidth limitation) these values might not correspond to those
actually received by the client.

*For Motion JPEG, these values will only be accurate as long as no frame rate limit has been
specified.
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Bandwidth

As there are many factors affecting bandwidth, it is very difficult to predict the required
amounts. The settings that affect bandwidth are:

the image resolution

the image compression

the frame rate

the MPEG-4 object type

the MPEG-4 GOV structure

the analog cameras connected to the video servervideo server
the audio settings

There are also factors in the monitored scene that will affect the bandwidth. These are:

the amount of motion
the image’s complexity
the lighting conditions.

For MPEG-4, if there is only limited bandwidth available, and if this is more important
than the image quality, using a constant bit rate (CBR) is recommended. Use a variable bit
rate (VBR) if the image quality needs to be maintained at a higher level. If supported on the
network, consider also using MPEG-4 multicasting, as the bandwidth consumption will be
much lower.



Glossary

Active Speaker - a speaker with a built-in power
amplifier.

ActiveX - ActiveX is a standard that enables software
components to interact with one another in a networked
environment, regardless of the language(s) used to create
them. Web browsers may come into contact with ActiveX
controls, ActiveX documents, and ActiveX scripts.
ActiveX controls are often downloaded and installed
automatically as required.

AF (Autofocus) - A system by which the camera lens
automatically focuses on a selected part of the subject.

AMC (AXIS Media Control) - AMC is the ActiveX
component required to view moving images from an Axis
video device in Internet Explorer. The component is
installed automatically on the viewing computer on first
use. Once installed, AMC can be configured from
Windows Control Panel.

Analog video camera - The signal from an analog video
camera is viewed directly on e.g. a monitor in the analog
system, which depends on traditional analog cabling.
Alternatively, the signal can be digitized with the use of a
video server, and can then be made available over a data
(IP) network.

Angle - The field of view, relative to a standard lens in a
35mm still camera, expressed in degrees, e.g. 30°. For
practical purposes, this is the area that a lens can cover,
where the angle of view is determined by the focal length
of the lens. A wide-angle lens has a short focal length and
covers a wider angle of view than standard or telephoto
lenses, which have longer focal lengths.

API (Application Programming Interface) - An APl is a
set of routines, protocols, and tools for building software
applications. A good API makes it easier to develop a
program by providing all the required building blocks.
The Axis VAPIX API allows Axis products to be
integrated into other applications.

ARP (Address Resolution Protocol) - This protocol is used
to associate an IP address to a hardware MAC address. A
request is broadcast on the local network to discover the
MAC address for an IP address.

ARTPEC (Axis Real Time Picture Encoder) - A chip
designed by Axis for image compression. ARTPEC
supports a range of CCD and CMOS sensors, built-in
functionality for sharpening, backlight compensation,
noise reduction and white balance, support for multiple
Motion-JPEG streams, support for MPEG-4 part 2, up to
30 frames/second from 4 simultaneous video sources and
real-time compression of up to 45 Megapixels/second.

ASIC (Application Specific Integrated Circuit) - A circuit
designed for a specific application, as opposed to a
general purpose circuit, such as a microprocessor.
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Aspect ratio - A ratio of width to height in images. A
common aspect ratio used for television screens and
computer monitors is 4:3. High-definition television
(HDTV) uses an aspect ratio of 9:16.

Autoiris (DC-Iris) - This special type of iris is electrically
controlled by the camera, to automatically regulate the
amount of light allowed to enter.

AVI (Audio Video Interleave) - A video format that
supports simultaneous playback of audio and video.

AXIS Internet Dynamic DNS Service - This free service
provides an Axis network product with a unique DNS or
domain name (URL address), which can then be used
instead of an IP address to access the product from a web
browser.

AXIS IP Utility - A tool for discovering and setting IP
addresses for Axis network devices. AXIS IP Utility is
supplied free of charge by Axis.

AXIS Camera Management - A powerful and efficient
installation and management tool for Axis network video
products. The tool can automatically find and set IP
addresses, show connection status and manage firmware
upgrades of multiple devices.

Bitmap - A bitmap is a data file representing a
rectangular grid of pixels. It defines a display space and
color for each pixel (or "bit”) in the display space. This
type of image is known as a "raster graphic.” GIF’s and
JPEG’s are examples of image file types that contain
bitmaps. Because a bitmap uses this fixed raster method,
it cannot easily be rescaled without losing definition.
Conversely, a vector graphic image uses geometrical
shapes to represent the image, and can thus be quickly
rescaled.

Bit rate - The bit rate (in kbit/s or Mbit/s) is often referred
to as speed, but actually defines the number of bits/time
unit and not distance/time unit.

Bluetooth - Bluetooth is an open standard for wireless
transmission of voice and data between mobile devices
(PCs, handheld computers, telephones and printers).

Bonjour - Also known as zero-configuration networking,
Bonjour enables the automatic discovery of computers,
devices, and services on IP networks. Bonjour allows
devices to automatically discover each other without the
need to enter IP addresses or configure DNS servers.
Bonjour is developed by Apple Computer Inc.

BOOTP (Bootstrap Protocol) - A protocol that can
automatically configure a network device (give it an IP
address). BOOTP is the basis for a more advanced network
management protocol, the Dynamic Host Configuration
Protocol (DHCP).

Broadband - In network engineering terms, this describes
transmission methods where two or more signals share
the same carrier. In more popular terminology, broadband
is taken to mean high-speed data transmission.



CCD (Charged Coupled Device) - This light-sensitive
image device used in many digital cameras is a large
integrated circuit that contains hundreds of thousands of
photo-sites (pixels) that convert light energy into
electronic signals. Its size is measured diagonally and can
be 1/4”, 1/3", 1/2” or 2/3".

CCTV (Closed Circuit Television) - A CCTV system is a
closed/private video system, usually constructed with
coaxial cabling, and used within a single building/group
of buildings. It is used to visually monitor the location for
security or industrial purposes. Video from the CCTV
system can be recorded and viewed on-site or remotely.

CCTV video camera - A traditional CCTV video camera is
an analog camera, available in both monochrome (black
and white) and color. Cameras can be set in fixed
positions or placed on "Pan/Tilt/Zoom” devices, which
allow the camera to be maneuvered. Using a zoom lens
provides a closer view of the object being viewed. CCTV
analog video cameras can be viewed over a computer
network by using a video server.

CGI (Common Gateway Interface) - A specification for
communication between a web server and other (CGI)
programs. For example, a HTML page that contains a form
might use a CGI program to process the form data once it
is submitted.

CIF (Common Intermediate Format) - CIF refers to the
analog video resolutions 352x288 pixels (PAL) and
352x240 pixels (NTSC). See also Resolution.

Client-server - Client-server describes the relationship
between two computer programs in which one program,
the client, makes a service request from another program,
the server, which fulfils the request. Typically, multiple
client programs share the services of a common server
program. A web browser is a client program that requests
services (the sending of web pages or files) from a web
server.

CMOS (Complementary Metal Oxide Semiconductor) - A
CMOS is a widely used type of semiconductor that uses
both negative and positive circuits. Since only one of the
circuit types is on at any given time, CMOS chips require
less power than chips using just one type of transistor.
CMOS image sensors also allow processing circuits to be
included on the same chip, an advantage not possible
with CCD sensors, which are also much more expensive to
produce.

Coaxial cable - Coaxial cable is the standard means of
transmitting analog video in a CCTV system. Coaxial is
also used by cable companies to distribute television in
residential buildings.

Codec - In communications engineering, a codec is
usually a coder/decoder. Codecs are used in integrated
circuits or chips that convert e.g. analog video and audio
signals into a digital format for transmission. The codec
also converts received digital signals back into analog
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format. A codec uses analog-to-digital conversion and
digital-to-analog conversion in the same chip.

Codec can also mean compression/decompression, in
which case it is generally taken to mean an algorithm or
computer program for reducing the size of large files and
programs.

Composite video - A type of video signal in which the
red, blue and green signals (sometimes audio signals too)
are mixed together.

Compression - See Image Compression.

Contrast - Defines the degree of difference between the
lightest and darkest parts of an image or video stream.

Control unit - If a CCTV system has more than one
camera, there must be a way to control the video signals
going to recorders and monitors. There are three basic
types of Video Control Unit: Multiplexer, Switch and
Quad.

dB (Decibels) - A unit to measure sound level changes. A
3dB change is the smallest level change we can hear. A
3dB change is actually twice or half the audio power
level. A gain of 0dB will leave the signal level unchanged.

DC-Iris - This special type of iris is electrically controlled
by the camera, to automatically regulate the amount of
light allowed to enter.

Decoder - See video decoder.
De-interlacing - See interlacing.

DHCP (Dynamic Host Configuration Protocol) - DHCP is
a protocol that lets network administrators automate and
centrally manage the assignment of Internet Protocol (IP)
addresses to network devices in a network.

DHCP uses the concept of a "lease” or amount of time that
a given IP address will be valid for a computer. The lease
time can vary, depending on how long a user is likely to
require the network connection at a particular location.

DHCP also supports static addresses for e.g. computers
running web servers, which need a permanent IP address.

DNS (Domain Name System) - DNS is used to locate and
translate Internet domain names into IP (Internet
Protocol) addresses. A domain name is a meaningful and
easy-to-remember name for an Internet address. For
example the domain name www.example.com is much
easier to remember than 192.0.34.166. The translation
tables for domain names are contained in Domain name
servers.

Domain server - Domains can also be used by
organizations that wish to centralize the management of
their (Windows) computers. Each user within a domain
has an account that usually allows them to log in to and
use any computer in the domain, although restrictions
may also apply. The domain server is the server that
authenticates the users on the network.



Dome network camera - A remotely controllable camera
mounted in a special housing, characterized by the dome
shaped glass or plastic covering behind which the camera
resides. Usually mounted on a ceiling and looking
downwards, a dome camera can often rotate up to 360
degrees, thus providing excellent coverage of large areas.

Duplex - See Full-duplex.

DVD (Digital Versatile Disc) - An optic disc with the
same physical size as a CD, but with significantly greater
storage capacity.

DVR (Digital Video Recorder) - A DVR records analog
video to a hard disk in digital format. Most DVR’s use the
MPEG-2 format for encoding analog video signals.

Encoder - See Video encoder.

Ethernet - Ethernet is the most widely installed local area
network technology. An Ethernet LAN typically uses
special grades of twisted pair wires. The most commonly
installed Ethernet systems are 10BASE-T and
100BASE-T10, which provide transmission speeds up to
10 Mbps and 100 Mbps respectively.

ETRAX (Ethernet Token Ring AXIS) - The ETRAX chip is
the cornerstone of Axis technology and the 'brain’ in
nearly all Axis products. A multipurpose Linux chip with
integrated Ethernet networking and extremely flexible I/O
options.

Factory default settings - These are the settings that
originally applied for a device when it was first delivered
from the factory. If it should become necessary to reset a
device to its factory default settings, this will, for many
devices, completely reset any settings that were changed
by the user.

Firewall - A firewall works as a barrier between networks,
e.g. between a Local Area Network and the Internet. The

firewall ensures that only authorized users are allowed to
access the one network from the other. A firewall can be
software running on a computer, or it can be a standalone
hardware device.

Fixed dome network camera - This type of camera
cannot be remotely controlled as regards movement, but
is mounted in the same type of dome as a controllable
network dome camera. This camera must be positioned
manually to provide the required coverage.

Fixed network camera - This type of camera cannot be
remotely controlled as regards movement. It must be
positioned manually to provide the required coverage.

Fixed iris - See Autoiris.

Focal length - Measured in millimeters, the focal length
of a camera lens determines the width of the horizontal
field of view, which in turn is measured in degrees.

FTP (File Transfer Protocol) - FTP is an application
protocol that uses the TCP/IP protocols, used to exchange
files between computers/devices on networks.
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Frame - A frame is a complete video image. In the 2:1
interlaced scanning format of the RS-170 and CCIR
formats, a frame is made up of two separate fields of
262.5 or 312.5 lines interlaced at 60 or 50 Hz to form a
complete frame, which appears at 30 or 25 Hz. In video
cameras with a progressive scan, each frame is scanned
line-by-line and not interlaced; most are also displayed at
30 and 25 Hz.

Frame rate - The frame rate used to describe the
frequency at which a video stream is updated is measured
in frames per second (fps). A higher frame rate is
advantageous when there is movement in the video
stream, as it maintains image quality throughout.

Full-duplex - Transmission of data in two directions
simultaneously. In an audio system this would describe
e.g. a telephone systems. Half-duplex also provides
bi-directional communication, but only in one direction
at a time, as in a walkie-talkie system. See also Simplex.

G.711 - The international standard for encoding
telephone audio on a 64 kbps channel. It is a pulse code
modulation (PCM) scheme operating at 8 kHz sample rate.

G.726 - A frequently used speech-compression algorithm
in telecommunications due to its high perceived speech
quality and low resource requirements.

Gain - Gain is the amplification factor and the extent to
which an analog amplifier boosts the strength of a signal.
Amplification factors are usually expressed in terms of
power. The decibel (dB) is the most common way of
quantifying the gain of an amplifier.

Gateway - A gateway is a point in a network that acts as
an entry point to another network. In a corporate network
for example, a computer server acting as a gateway often
also acts as a proxy server and a firewall server. A
gateway is often associated with both a router, which
knows where to direct a given packet of data that arrives
at the gateway, and a switch, which furnishes the actual
path in and out of the gateway for a given packet.

GIF (Graphics Interchange Format) - GIF is one of the
most common file formats used for images in web pages.
There are two versions of the format, 87a and 89a.
Version 89a supports animations, i.e. a short sequence of
images within a single GIF file. A GIF89a can also be
specified for interlaced presentation.

GOV (Group Of VOPs) - A group of VOP’s is the basic
unit of an MPEG-4 video stream. The GOV contains
different types and numbers of VOP’s (I-VOP’s, P-VOP’s,
etc) as determined by the GOV length and GOV structure.
See also VOP.

GOV length - The GOV length determines the number of
images (VOP’s) in the GOV structure.
See also GOV and VOP.

GOV structure - The GOV structure describes the
composition of an MPEG-4 video stream, as regards the



type of images (I-VOP’s or P-VOP’s) included in the
stream, and their internal order. See also GOV and VOP.

Half-duplex - See Full-duplex.

HTML (Hypertext Markup Language) - HTML is the set

of "markup” symbols or codes inserted in a file intended
for display in web browser. The markup tells the browser
how to display the page’s words and images for the user.

HTTP (Hypertext Transfer Protocol) - HTTP is the set of
rules for exchanging files (text, graphic images, sound,
video, and other multimedia files) on the web. The HTTP
protocol runs on top of the TCP/IP suite of protocols.

HTTPS (Hypertext Transfer Protocol over SSL) - HTTPS
is a protocol used by web browsers and servers to encrypt
and decrypt user page requests and the pages returned by
the server. The encrypted exchange of information is
governed by the use of an HTTPS certificate (issued by a
Certificate Authority), which guarantees the authenticity
of the server.

Hub - A (network) hub is used to connect multiple devices
to the network. The hub transmits all data to all devices
connected to it, whereas a switch will only transmit the
data to the device it is specifically intended for.

IEEE 802.11 - A family of standards for wireless LANs.
The 802.11a standard supports 1 or 2 Mbit/s transmission
on the 5 GHz band. IEEE 802.11b supports data rates up
to11 Mbit/s on the 2.4 GHz band, while 802.11¢g allows
up to 54 Mbit/s on the 2.4 GHz band.

Image compression - Image compression minimizes the
file size (in bytes) of an image. Two of the most common
compressed image formats are JPEG and GIF. See also
MPEG and Motion JPEG.

Interlacing - Interlaced video is video captured at 50
pictures (known as fields) per second, of which every 2
consecutive fields (at half height) are then combined into
1 frame. Interlacing was developed many years ago for
the analog TV world and is still used widely today. It
provides good results when viewing motion in standard
TV pictures, although there is always some degree of
distortion in the image.

To view interlaced video on e.g. a computer monitor, the
video must first be de-interlaced, to produce progressive
video, which consists of complete images, one after the

other, at 25 frames per second. See also Progressive scan.

IP (Internet Protocol) - The Internet Protocol is a method
transmitting data over a network. Data to be sent is
divided into individual and completely independent
"packets.” Each computer (or host) on the Internet has at
least one address that uniquely identifies it from all
others, and each data packet contains both the sender’s
address and the receiver’s address.

The Internet Protocol ensures that the data packets all
arrive at the intended address. As IP is a connectionless
protocol, which means that there is no established
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connection between the communication end-points,
packets can be sent via different routes and do not need
to arrive at the destination in the correct order.

Once the data packets have arrived at the correct
destination, another protocol - Transmission Control
Protocol (TCP) - puts them in the right order.

See also TCP.

IP address - An IP address is simply an address on an IP
network used by a computer/device connected to that
network. IP addresses allow all the connected
computers/devices to find each other and to pass data
back and forth.

To avoid conflicts, each IP address on any given network
must be unique. An IP address can be assigned as fixed,
so that it does not change, or it can be assigned
dynamically (and automatically) by DHCP.

An IP address consists of four groups (or quads) of
decimal digits separated by periods, e.g. 130.5.5.25.
Different parts of the address represent different things.
Some part will represent the network number or address,
and some other part will represent the local machine
address. See also IP (Internet Protocol).

Infrared (IR) - Infrared radiation is radiation at a longer
wavelength than visible light, which means it cannot be
seen by the naked human eye. As infrared radiation can
be detected as heat, this can be shown on a screen or
captured by a digital camera, with hotter objects showing
up brighter against colder surroundings (e.g. a human
body against a colder background).

As color cameras can "see” infrared radiation as well as
visible light, these cameras are equipped with an IR-cut
filter, to prevent distortion of the colors the human eye
can see. To use the camera in very dark locations or at
night, this filter can be removed, to allow infrared
radiation to hit the image sensor and thus produce
images. An infrared lamp can be used for improved
illumination for night surveillance, while not producing
any extra visible light.

Inputs/Outputs (I/0’s) - The digital I/Os on, for example,
a network camera can be used to connect any device that
can toggle between an open and a closed circuit.

For example, if a door switch is used as an input device,
opening the door could trigger the upload of video images
and the sending of notification messages.

An output might, for example, be used to automatically
start a siren when there is a motion detection trigger.

ISMA (Internet Streaming Media Alliance) - ISMA’s goal
is: "To accelerate the adoption and deployment of open
standards for streaming rich media content such as video,
audio, and associated data, over Internet protocols.”

I-VOP - See VOP.



JPEG (Joint Photographic Experts Group) - Together
with the GIF file format, JPEG is an image file type
commonly used on the web. A JPEG image is a bitmap,
and usually has the file suffix ".jpg’ or ".jpeg.” When
creating a JPEG image, it is possible to configure the level
of compression to use. As the lowest compression (i.e. the
highest quality) results in the largest file, there is a
trade-off between image quality and file size.

kbit/s (kilobits per second) - A measure of the bit rate,
i.e. the rate at which bits are passing a given point. See
also Bit rate.

LAN (Local Area Network) - A LAN is a group of
computers and associated devices that typically share
common resources within a limited geographical area.

Linux - Linux is an open source operating system within
the Unix family. Because of its robustness and
availability, Linux has won popularity in the open source
community and among commercial application
developers.

Lux - A standard unit of illumination measurement.

MAC address (Media Access Control address) - A MAC
address is a unique identifier associated with a piece of
networking equipment, or more specifically, its interface
with the network. For example, the network card in a
computer has its own MAC address.

Manual iris - This is the opposite of an autoiris, i.e. the
camera iris must be adjusted manually to regulate the
amount of light allowed to reach the image sensor.

Mbit/s (Megabits per second) - A measure of the bit rate,
i.e. the rate at which bits are passing a given point.
Commonly used to give the "speed” of a network. A LAN
might run at 10 or 100 Mbit/s. See also Bit rate.

Monitor - A monitor is very similar to a television set, but
lacks the electronics to pick up regular television signals.

Motion JPEG - Motion JPEG is a simple
compression/decompression technique for network video.
Latency is low and image quality is guaranteed, regardless
of movement or complexity of the image. Image quality is
controlled by adjusting the compression level, which in
turn provides control over the file size, and thereby the bit
rate.

High-quality individual images from the Motion JPEG
stream are easily extracted. See also JPEG and GIF.

Megapixel - See Pixel.

MPEG (Moving Picture Experts Group) - The Moving
Picture Experts Group develops standards for digital video
and audio compression. It operates under the auspices of
the International Organization for Standardization (ISO).
The MPEG standards are an evolving series, each designed
for a different purpose.
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MPEG-2 - The designation for a group of audio and video
coding standards, and is typically used to encode audio
and video for broadcast signals, including digital satellite
and Cable TV. MPEG-2, with some modifications, is also
the coding format used by standard commercial DVD
movies.

MPEG-4 - MPEG-4 is a group of audio and video coding
standards and related technology. The primary uses for
the MPEG-4 standard are web (streaming media) and CD
distribution, conversational (videophone), and broadcast
television.

Most of the features included in MPEG-4 are left to
individual developers to decide whether to implement
them or not. This means that there are probably no
complete implementations of the entire MPEG-4 set of
standards. To deal with this, the standard includes the
concept of "profiles” and "levels”, allowing a specific set
of capabilities to be defined in a manner appropriate for a
subset of applications.

Multicast - Bandwidth-conserving technology that
reduces bandwidth usage by simultaneously delivering a
single stream of information to multiple network
recipients. See also Unicast.

Multiplexer - A multiplexer is a high-speed switch that
provides full-screen images from up to 16 analog
cameras. Multiplexers can playback everything that
happened on any one camera with no interference from
the other cameras on the system.

Network camera (Network video camera) - A network
camera is a camera and computer combined in one
intelligent unit. It captures and sends live video directly
over an IP network such as a LAN, intranet or the
Internet. Users can view and/or manage the camera using
a standard web browser or application software from any
local or remote computer on a network. The camera
allows multiple authorized viewers from different
locations to simultaneously access images. A network
camera is sometimes known as an IP camera.

Network connectivity - The physical (wired or wireless)
and logical (protocol) connection of a computer network
or an individual device to a network, such as the Internet
or a LAN.

Network video - Network video (often referred to as
IP-Surveillance for specific applications within security
surveillance and remote monitoring) is a system that gives
users the ability to monitor and record video over an IP
network (LAN/WAN/Internet).

NTSC (National Television System Committee) - NTSC is
an analog color encoding system used in television
systems in Japan, the United States and other parts of the
Americas. NTSC defines the video signal using 525 TV
lines per frame, at a refresh rate equal to 30 frames per
second. See also PAL.



NVR (Network Video Recorder) - A dedicated Network
Video Recorder (NVR) can be used to gather data streams
from remote network cameras and video servers and store
them on a hard disk. An NVR can be a standard
networked PC, or a dedicated video recording hard disk
server with its own software application.

OEM (Original Equipment Manufacturer) - This is a
designation for companies that manufacture equipment
that is then marketed and sold to other companies under
their own names.

PAL (Phase Alternating Line) - PAL is an analog color
encoding system used in television systems in Europe and
in many other parts of the world. PAL defines the video
signal using 625 TV lines per frame, at a refresh rate
equal to 25 frames per second. See also NTSC.

PDA (Personal Digital Assistant) - A small handheld
computer, which usually provides at least a calendar, an
organizer and a notepad.

PEM (Privacy Enhanced Mail) - An early standard for
securing electronic mail. The PEM-format is often used
for representing an HTTPS certificate or certificate
request.

Ping - Ping is a basic network program used
diagnostically to check the status of a network host or
device. Ping can be used to see if a particular network
address (IP address or host name) is occupied or not, or if
the host at that address is responding normally. Ping can
be run from e.g. the Windows Command prompt or the
command line in Unix.

Pixel (Picture Element) - A pixel is one of the many tiny
dots that make up a digital image. The color and intensity
of each pixel represents a tiny area of the complete image.

PoE (Power over Ethernet) - Power over Ethernet
provides power to a network device via the same cable as
used for the network connection. This is very useful for
IP-Surveillance and remote monitoring applications in
places where it may be too impractical or expensive to
power the device from a power outlet.

PPP (Point-to-Point Protocol) - A protocol that uses a
serial interface for communication between two network
devices. For example, a PC connected by a phone line to a
server.

PPTP (Point-to-Point Tunneling Protocol) - A protocol
(set of communication rules) that allows corporations to
extend their own corporate network through private
“tunnels” over the public Internet. In this way a
corporation can effectively use a WAN (Wide Area
Network) as a large single LAN (Local Area Network). This
kind of interconnection is known as a virtual private
network (VPN).

Pre/post alarm images - The images from immediately
before and after an alarm. These images are stored in a
buffer for later retrieval.
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Progressive scan - Progressive scan, as opposed to
interlaced video, scans the entire picture, line by line
every sixteenth of a second. In other words, captured
images are not split into separate fields as in interlaced
scanning.

Computer monitors do not need interlace to show the
picture on the screen, but instead show them
progressively, on one line at a time in perfect order i.e. 1,
2, 3, 4, 5, 6, 7 etc., so there is virtually no "flickering”
effect. In a surveillance application, this can be critical
when viewing detail within a moving image, such as a
person running. A high-quality monitor is required to get
the best from progressive scan. See also Interlacing.

Protocol - A special set of rules governing how two
entities will communicate. Protocols are found at many
levels of communication, and there are hardware
protocols and software protocols.

Proxy server - In an enterprise that uses the Internet, a
proxy server acts as an intermediary between a
workstation user and the Internet. This provides security,
administrative control, and a caching service. Any proxy
server associated with a gateway server, or part of a
gateway server, effectively separates the enterprise
network from the outside network and the local firewall.
It is the firewall server that protects the enterprise
network from outside intrusion.

PTZ (Pan Tilt Zoom) - A PTZ-enabled camera can be
remotely controlled so as to change the view from the
camera. Panning is the movement of the camera along its
horizontal axis, tilting is the movement of the camera
along its vertical axis, and zooming is the adjustment of
the zoom lens to magnify the view.

P-VOP - See VOP.

Quad view - A Quad view displays images from up to
four cameras on a single screen; where the images from
each camera take up approximately a quarter of the
display area.

Remote monitoring - Network video gives users the
ability to gather information at all key points of an
operation and view it in realtime. This makes the
technology ideal for monitoring equipment, people and
places, both locally and remotely. Application examples
include traffic and production line monitoring, and the
monitoring of multiple store locations.

Resolution - Image resolution is a measure of how much
detail a digital image can hold: the greater the resolution,
the greater the level of detail. Resolution can be specified
as the number of pixel-columns (width) by the number of
pixel-rows (height), e.g. 320x240.

Alternatively, the total number of pixels (usually in
megapixels) in the image can be used. In analog systems
it is also common to use other format designations, such
as CIF, QCIF, 4CIF, etc.
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RS-232 - A long-established standard that describes the

physical interface and protocol for low-speed serial data

communication between devices. This is the interface that
e.g. a computer uses to talk to and exchange data with a

modem and other serial devices.

RS-422 - A serial data communication protocol that
specifies 4-wire, full-duplex, differential line, multi-drop
communications. It provides balanced data transmission
with unidirectional/non-reversible, terminated or
non-terminated transmission lines. RS-422 does not allow
multiple drivers, only multiple receivers. Maximum
recommended range is 4,000 feet (1200 meters).
Maximum recommended baud rate is 10Mbit/s.

RS-485 - An upgraded version of RS-422 that supports
up to 32 devices on the same connection. RS-485 is an
electrical specification of a two-wire, half-duplex,
multipoint serial connection. It enables the configuration
of inexpensive local networks and multidrop
communications links. It offers high data transmission
speeds (up to 10Mbit/s), and as it uses a differential
balanced line over twisted pair (like RS-422), it can span
relatively large distances (4000 feet or 1200 meters).
RS-485 only specifies the electrical characteristics of the
driver and the receiver. It does not specify or recommend
any data protocol.

RTCP (Real-Time Control Protocol) - RTCP provides
support for real-time conferencing of groups of any size
within an intranet. This support includes source
identification and support for gateways like audio and
video bridges as well as multicast-to-unicast translators.
It offers quality-of-service feedback from receivers to the
multicast group as well as support for the synchronization
of different media streams.

RTP (Real-Time Transport Protocol) - An Internet
protocol for the transport of real-time data, e.g. audio and
video. It can be used for media-on-demand as well as
interactive services such as Internet telephony.

RTSP (Real Time Streaming Protocol) - A control
protocol, and a starting point for negotiating transports
such as RTP, multicast and Unicast, and for negotiating
codecs. RTSP can be considered a "remote control” for
controlling the media stream delivered by a media server.
RTSP servers typically use RTP as the protocol for the
actual transport of audio/video data.

Router - A device that determines the next network point
to which a packet should be forwarded on its way to its
final destination. A router creates and/or maintains a
special routing table that stores information on how best
to reach certain destinations. A router is sometimes
included as part of a network switch. See also Switch.

Security surveillance - Network video’s advanced
functionality makes it highly suited to the applications
involved in security surveillance. The flexibility of digital
technology enhances security personnel’s ability to
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protect people, property and assets. Such systems are
therefore an especially attractive option for companies
currently using CCTV.

Server - In general, a server is a computer program tha
provides services to other computer programs in the same
or other computers. A computer running a server program
is also frequently referred to as a server. In practice, the
server may contain any number of server and client
programs. A web server is the computer program that
supplies the requested HTML pages or files to the client
(web browser).

Sharpness - This is the control of fine detail within a
picture. This feature was originally introduced into color
TV sets that used notch filter decoders. This filter took
away all high frequency detail in the black and white
region of the picture. The sharpness control attempted to
put some of that detail back in the picture. Sharpness
controls are mostly superfluous in today’s high-end TVs.
The only logical requirement for it nowadays is on a VHS
machine.

Simplex - In simplex operation, a network cable or
communications channel can only send information in
one direction. See also Full-duplex.

SMTP (Simple Mail Transfer Protocol) - Used for sending
and receiving e-mail. However, as it is "simple,” it is
limited in its ability to queue messages at the receiving
end, and is usually used with one of two other protocols,
POP3 or IMAP. These other protocols allow the user to
save messages in a server mailbox and download them
periodically from the server.

SMTP authentication - An extension of SMTP, where the
client is required to log into the mail server before or
during the sending of email. It can be used to allow
legitimate users to send email while denying the service to
unauthorized users, such as spammers.

SNMP (Simple Network Management Protocol) - SNMP
forms part of the Internet Protocol suite, as defined by the
Internet Engineering Task Force. The protocol can support
monitoring of network-attached devices for any
conditions that warrant administrative attention.

Sockets - Sockets are a method for communication
between a client program and a server program over a
network. A socket is defined as "the endpoint in a
connection.” Sockets are created and used with a set of
programming requests or "function calls” sometimes
called the sockets application programming interface
(API).

SSL/TSL

(Secure Socket Layer/Transport Layer Security) - These
two protocols (SSL is succeeded by TSL) are cryptographic
protocols that provide secure communication on a
network. SSL is commonly used over HTTP to form
HTTPS, as used e.g. on the Internet for electronic financial
transactions. SSL uses public key certificates to verify the



identity of the server.

Subnet & subnet mask - A subnet is an identifiably
separate part of an organization’s network. Typically, a
subnet may represent all the machines at one geographic
location, in one building, or on the same local area
network (LAN). Having an organization’s network divided
into subnets allows it to be connected to the Internet with
a single shared network address.

The subnet mask is the part of the IP address that tells a
network router how to find the subnet that the data
packet should be delivered to. Using a subnet mask saves
the router having to handle the entire 32-bit IP address; it
simply looks at the bits selected by the mask.

Switch - A network device that connects network
segments together, and which selects a path for sending a
unit of data to its next destination. In general, a switch is
a simpler and faster mechanism than a router, which
requires knowledge about the network and how to
determine the route. Some switches include the router
function. See also Router.

TCP (Transmission Control Protocol) - TCP is used along
with the Internet Protocol (IP) to transmit data as packets
between computers over the network. While IP takes care
of the actual packet delivery, TCP keeps track of the
individual packets that the communication (e.g. requested
a web page file) is divided into, and, when all packets
have arrived at their destination, it reassembles them to
re-form the complete file.

TCP is a connection-oriented protocol, which means that
a connection is established between the two end-points
and is maintained until the data has been successfully
exchanged between the communicating applications.

Telnet - Telnet is a simple method with which to access
another network device, e.g. a computer. The HTTP
protocol and the FTP protocols allow you to request
specific files from remote computers, but do not allow you
logon as a user of that computer. With Telnet, you log on
as a regular user with whatever privileges you may have
been granted for specific applications and data residing
on that computer.

Time-lapse recorder - This type of video recorder is
commonly used in the security industry and has the
ability to record up to one week of video on a single tape.
The most commonly used timing is the 24-hour mode.
Having to change tapes only once a day and retaining
large amounts of information are perceived as key
advantages in using this particular mode of recording,.

TVL (TV Lines) - A method of defining resolutions in
analog video.

UDP (User Datagram Protocol) - UDP is a
communications protocol that offers limited service for
exchanging data in a network that uses the Internet
Protocol (IP). UDP is an alternative to the Transmission
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Control Protocol (TCP). The advantage of UDP is that it is
not required to deliver all data and may drop network
packets when there is e.g. network congestion. This is
suitable for live video, as there is no point in
re-transmitting old information that will not be displayed
anyway.

Unicast - Communication between a single sender and a
single receiver over a network. A new connection is
established for each new user. See also Multicast.

UPnP™ - A set of computer network protocols that allows
the automatic peer-to-peer detection of devices on the
network. UPnP is promoted by the UPnP Forum.

URL (Uniform Resource Locator) - An "address” on the
network.

USB (Universal Serial Bus) - A plug-and-play interface
between a computer and peripheral devices (scanners,
printers etc)

Varifocal lens - A lens that provides a wide range of focal
lengths, as opposed to a lens with a fixed focal length,
which only provides one.

Video camera - See Network camera and CCTV video
camera.

Video decoder - A network video decoder converts digital
video and audio streams back into analog signals, which
can then be displayed on standard TV sets, analog
monitors and video switches.

Video encoder (video server) - A video encoder/server
digitizes analog video signals and sends digital images
directly over an IP network, such as a LAN, intranet or the
Internet. In effect, it turns an analog video system into a
network video system and enables users to view live
images using a web browser or application software on
any local or remote computer on a network.

Video management software - Video management
software supplies the means for monitoring, analyzing
and recording network video. In its simplest form, it offers
live viewing, storage and retrieval of video sequences.
Advanced applications may also provide support for
recording of live video from multiple devices, different
recording modes, search functions, remote access via a
web browser, control of PTZ devices, etc.

VMD (Video Motion Detection) - Video Motion detection
defines activity (motion) in a monitored scene by
analyzing image data and differences in series of images.
This detection can, for example, be used to trigger an
alarm event in a network camera and start the upload of
images from the camera.

Video switcher - An analog video switcher sequentially
displays full screen images, from one camera after
another, typically at 3-5 seconds intervals. Other camera
sources are not recorded while the image source from one
camera is displayed on screen.



VPN (Virtual Private Network) - This creates a secure
“tunnel” between the points within the VPN. Only devices
with the correct "key” will be able to work within the
VPN. The VPN network can be within a company LAN
(Local Area Network), but different sites can also be
connected over the Internet in a secure way. One common
use for VPN is for connecting a remote computer to the
corporate network, via e.g. a direct phone line or via the
Internet.

VOP (Video Object Plane) - A VOP is an image frame in

an MPEG-4 video stream. There are several types of VOP:

- An I-VOP is a complete image frame.

- An P-VOP codes the differences between images, as long
as it is more efficient to do so. Otherwise it codes the
whole image, which may also be a completely new image.

WAN (Wide-Area-Network) - Similar to a LAN, but on a
larger geographical scale.

W-LAN (Wireless LAN) - A wireless LAN is a wireless
local area network that uses radio waves as its carrier:
where the network connections for end-users are wireless.
The main network structure usually uses cables.

Web camera (Webcam) - A camera that requires a
constant connection (via e.g. USB) to a PC for its
operation. See also Network camera.

Web server - A program that allows web browsers to
retrieve files from computers connected to the Internet.
The Web server listens for requests from browsers and
upon receiving a request for a file sends it back to the
browser. The primary function of a Web server is to serve
pages to other remote computers.

WEP (Wireless Equivalent Privacy) - A wireless security
protocol, specified in the IEEE 802.11 standard, which is
designed to provide a wireless local area network (WLAN)
with a level of security and privacy comparable to that
usually expected of a wired LAN. Security is at two
different levels; 40-bit and 128-bit encryption. The higher
the bit number, the more secure the encryption.

WINS (Windows Internet Naming Service) - Part of the
Microsoft Windows NT Server, WINS manages the
association of workstation names and locations with IP
addresses, without the user or administrator having to be
involved in each configuration change.

WPA-PSK (Wi-Fi Protected Access - Pre-Shared Key) -
This wireless encryption method uses a pre-shared key
(PSK) for key management. Keys can usually be entered as
manual hex values, as hexadecimal characters, or as a
Passphrase. WPA-PSK provides a greater degree of
security than WEP.

Zoom lens - A zoom lens can be moved (zoomed) to
enlarge the view of an object to show more detail.
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